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About the Release Notes

About the Release Notes
The Release Notes are a comprehensive user guide for the latest release of Salesforce. Unlike a traditional release notes document
that includes only a simple list of enhancements, the Salesforce Release Notes give you everything you need to get up and
running with the new features and enhancements in the latest release.
What's Included in the Release Notes
For every new major enhancement, the Release Notes provide:
•
•
•
•

A brief, high-level description of the functionality
Implementation tips to help you get started with setup and administration
Best practice tips to help you maximize the benefit of the functionality
Complete end-to-end instructions on how to set up and use the functionality

Beyond the major new features, the Additional Enhancements sections include a list and brief description of every other
enhancement or functional change included in the latest release—everything from new user permissions, to workflow
enhancements, to new operators for formulas, to additional fields that are available in standard reports.
Let the Release Notes be your guide to success with the latest release from salesforce.com!
Your Feedback Matters
At salesforce.com, we know how important the Release Notes, online help, and documentation are to your company's success
with Salesforce. To continually improve the content we deliver to you, we want to know what works and what doesn't. Let us
know!
•

•

Feedback forms—Every HTML documentation page, both in the online help and in our developer guides at Developer
Force, includes a feedback form for you to submit your suggestions, corrections, and feedback about the documentation.
Since Spring '09, we have received more than 80 comments, resulting in nearly 40 corrections and additions to the
documentation for Summer '09.
Salesforce IdeaExchange—We're listening to your ideas too. Summer '09 includes your top documentation-related ideas:
"Include Date on Release Notes" and "Visualforce lifecycle documentation." Visit Salesforce IdeaExchange for a complete
list of ideas coming in Summer '09.

Want to be notified whenever we publish new documentation or make significant updates to existing documentation? Follow
us on Twitter: @salesforcedocs.
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Summary of Summer '09 Features and Impact on Salesforce
Users
Summer '09 includes features that will immediately impact all Salesforce users when the release occurs. You may want to
communicate these changes to the users in your organization before the release so that they are prepared for any changes that
might affect them. Other features require direct action by a Salesforce administrator before your users can benefit from the
new functionality.
The following tables summarize the Summer '09 features and whether they will have an immediate impact on users.

Salesforce Applications Enhancements
Calendar and Activity Management
Feature

Automatically
Automatically
visible to all users. visible to all
No setup required. administrators. No
setup required.

Not automatically Contact
visible. Feature is salesforce.com to
enabled but
enable this feature.
requires some
setup.

Automatically
Automatically
visible to all users. visible to all
No setup required. administrators. No
setup required.

Not automatically Contact
visible. Feature is salesforce.com to
enabled but
enable this feature.
requires some
setup.

Recurring Tasks
Recurring Event Enhancements

Salesforce CRM Content
Feature

Content Delivery Password Protection
Additional Options in Salesforce CRM
Content Reports
Enable or Disable Content Packs and
Presentations

3

Summary of Summer '09 Features and Impact on Salesforce Users

Marketing Automation
Feature

Automatically
Automatically
visible to all users. visible to all
No setup required. administrators. No
setup required.

Not automatically Contact
visible. Feature is salesforce.com to
enabled but
enable this feature.
requires some
setup.

Automatically
Automatically
visible to all users. visible to all
No setup required. administrators. No
setup required.

Not automatically Contact
visible. Feature is salesforce.com to
enabled but
enable this feature.
requires some
setup.

Automatically
Automatically
visible to all users. visible to all
No setup required. administrators. No
setup required.

Not automatically Contact
visible. Feature is salesforce.com to
enabled but
enable this feature.
requires some
setup.

Automated Campaigns
Generic From Email Address Support

Partner Relationship Management
Feature

Salesforce to Salesforce Enhancements
Salesforce to Salesforce: Automatically
Map Fields
Salesforce to Salesforce: Auto-Accept
Records
Salesforce to Salesforce: Share Cases
Salesforce to Salesforce: Share Case
Comments

Salesforce Mobile
Feature

Mobile Lite
Cloning Records for BlackBerry and
iPhone
Logout Feature for BlackBerry and
iPhone
List View Enhancements for iPhone
Convert Leads for iPhone
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Feature

Automatically
Automatically
visible to all users. visible to all
No setup required. administrators. No
setup required.

Not automatically Contact
visible. Feature is salesforce.com to
enabled but
enable this feature.
requires some
setup.

Calendar-like Event View for iPhone
Product and Price Book Support for
iPhone
Updated Actions Toolbar for iPhone
App Info Toolbar for iPhone
Schema-Driven Related Lists for iPhone
Related Lists on Detail Pages for
BlackBerry
Custom Embedded Links to Visualforce
and Web Tabs for BlackBerry and
iPhone
Visualforce Mobile JavaScript Library
for iBlackBerry and iPhone

Sales Force Automation and Other Applications Enhancements
Feature

Automatically
Automatically
visible to all users. visible to all
No setup required. administrators. No
setup required.

Not automatically Contact
visible. Feature is salesforce.com to
enabled but
enable this feature.
requires some
setup.

List Views for Account Teams
List Views for Sales Teams
Contact Manager Edition
Personal Edition Enhancements
Salesforce CRM Ideas Enhancements
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Service and Support
Feature

Automatically
Automatically
visible to all users. visible to all
No setup required. administrators. No
setup required.

Not automatically Contact
visible. Feature is salesforce.com to
enabled but
enable this feature.
requires some
setup.

Generic From Email Address Support
Automatically Exclude Portal Users from
Folders
Disabling and Deactivating Portal Users
Disabling Portal Accounts
Transfer Portal-Enabled Contacts
Between Accounts
Merge Portal-Enabled Contacts
Remove the Submit & Add Attachment
Button from the Customer Portal
Solution Search Results Display Accurate
Numbers of Matching Solutions
Solution Search Results on Cases Display
Fields Specified in the Solutions Search
Results Layout
Email Alerts for Case Comment
Workflow
Printable View Prints Solutions Correctly
in the Self-Service Portal
CTI (Computer-Telephony Integration)
Support for Firefox

Force.com Platform Enhancements
Administration and Sharing Enhancements
Feature

Automatically
Automatically
visible to all users. visible to all
No setup required. administrators. No
setup required.

Not automatically Contact
visible. Feature is salesforce.com to
enabled but
enable this feature.
requires some
setup.

Force.com Profile Enhancements
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Feature

Automatically
Automatically
visible to all users. visible to all
No setup required. administrators. No
setup required.

Not automatically Contact
visible. Feature is salesforce.com to
enabled but
enable this feature.
requires some
setup.

Automatically
Automatically
visible to all users. visible to all
No setup required. administrators. No
setup required.

Not automatically Contact
visible. Feature is salesforce.com to
enabled but
enable this feature.
requires some
setup.

Login IP Addresses and Login Hours
are Copied to Custom Profiles
Profile Change Tracking Added to Setup
Audit Trail
Role and Territory Hierarchies of 1,000
or More—List View Unavailable
Sharing Setup UI Enhancements
Profile Sharing Overrides

Analytics Enhancements
Feature

Chart Analytics 2.0
New Setup Navigation for Report and
Dashboard Settings
Packageable Analytic Snapshots
New Default Record Type for Analytic
Snapshots
Improved Filtering on Translated
Multi-Select Picklists in Reports
New Character and Compiled-Formula
Limits for Custom Summary Formulas
New Color Palette for Charts Available
for Color-Blind Users
Updated Button Name for Unscheduling
Dashboard Refreshes
Updated Online Help Topic on Chart
and Component Types

7

Summary of Summer '09 Features and Impact on Salesforce Users

Apex and Visualforce Enhancements
Feature

Automatically
Automatically
visible to all users. visible to all
No setup required. administrators. No
setup required.

Not automatically Contact
visible. Feature is salesforce.com to
enabled but
enable this feature.
requires some
setup.

Visualforce Enhancements
Planned S-Control Deprecation in Favor
of Visualforce Pages
Force.com Apex Code Enhancements

Application Distribution Enhancements
Feature

Automatically
Automatically
visible to all users. visible to all
No setup required. administrators. No
setup required.

Not automatically Contact
visible. Feature is salesforce.com to
enabled but
enable this feature.
requires some
setup.

Automatically
Automatically
visible to all users. visible to all
No setup required. administrators. No
setup required.

Not automatically Contact
visible. Feature is salesforce.com to
enabled but
enable this feature.
requires some
setup.

Application Distribution: Version
Tracking Enhancements
Application Distribution: Versioning and
Deprecation for Apex

Customization Enhancements
Feature

Process Visualizer (BETA)
Enhanced Declarative Logic For Picklists
Custom Label Limit Increased
Encoding Functions in Formulas
Language Characteristics of Workflow
Tasks and Email Notifications
Unique Name Added to Workflow
Actions and Approval Processes
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Force.com Sites Enhancements
Feature

Automatically
Automatically
visible to all users. visible to all
No setup required. administrators. No
setup required.

Not automatically Contact
visible. Feature is salesforce.com to
enabled but
enable this feature.
requires some
setup.

Automatically
Automatically
visible to all users. visible to all
No setup required. administrators. No
setup required.

Not automatically Contact
visible. Feature is salesforce.com to
enabled but
enable this feature.
requires some
setup.

Automatically
Automatically
visible to all users. visible to all
No setup required. administrators. No
setup required.

Not automatically Contact
visible. Feature is salesforce.com to
enabled but
enable this feature.
requires some
setup.

Force.com Sites Usage Reporting
Automatic Caching Support for
Force.com Sites Pages
Validation of Custom Web Address for
Force.com Sites
Updated Limits and Billing for
Force.com Sites
New 24-Hour Usage History Related
List

Search Enhancements
Feature

Search Result Ordering
Search Optimized for Japanese, Chinese,
and Korean
Use Recently Viewed User Records for
User Lookups

Security Enhancements
Feature

Security Assertion Markup Language
(SAML) 2.0 Supported
Security Question Required When User
Resets Password
More Information Emailed to User
When Password Reset Rejected
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User Interface and Other Force.com Platform Enhancements
Feature

Automatically
Automatically
visible to all users. visible to all
No setup required. administrators. No
setup required.

Not automatically Contact
visible. Feature is salesforce.com to
enabled but
enable this feature.
requires some
setup.

Force.com Platform Documentation
Enhancements
New Languages Supported by Salesforce
New Option to Load Record Detail
Pages More Quickly
New Default Values for Certain User
Interface Options
Toggle Spell Checker Functionality

Web Services API and Developer Tools
Feature

Automatically
Automatically
visible to all users. visible to all
No setup required. administrators. No
setup required.

Not automatically Contact
visible. Feature is salesforce.com to
enabled but
enable this feature.
requires some
setup.

Force.com Development as a Service
Force.com Web Services API
Enhancements
Monitoring Metadata Deployments
Force.com - Free User License
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SALESFORCE APPLICATIONS
Salesforce Mobile Enhancements
Available in: Enterprise, Professional, Unlimited, and Developer Editions

Summer '09 includes many new features that improve the capabilities of Salesforce Mobile.
Features for BlackBerry, iPhone, and Windows Mobile:
•

Mobile Lite

Features for BlackBerry and iPhone:
•
•
•
•

Cloning Records for BlackBerry and iPhone
Logout Feature for BlackBerry and iPhone
Custom Embedded Links to Visualforce and Web Tabs for BlackBerry and iPhone
Visualforce Mobile JavaScript Library for iBlackBerry and iPhone

Features for iPhone:
•
•
•
•
•
•
•

List View Enhancements for iPhone
Convert Leads for iPhone
Calendar-like Event View for iPhone
Product and Price Book Support for iPhone
Updated Actions Toolbar for iPhone
App Info Toolbar for iPhone
Schema-Driven Related Lists for iPhone

Features for BlackBerry:
•

Related Lists on Detail Pages for BlackBerry

About Salesforce Mobile Enhancements
Mobile Lite
Mobile Lite is a free, restricted version of Salesforce Mobile that is available to Enterprise, Professional, Unlimited, and
Developer Edition users who do not have a mobile license. Mobile Lite does not include all of the features offered in Salesforce
Mobile, which is the full version of the mobile client application. Mobile Lite users can view accounts, assets, contacts, leads,
opportunities, events, tasks, cases, solutions, reports, and dashboards. While the ability to create, edit, and delete records is
disabled for most of the standard objects in Mobile Lite, users can create, edit, and delete activities.
Mobile Lite users are automatically assigned to the default mobile configuration when they activate their Salesforce account
from a BlackBerry, iPhone, or Windows Mobile device.
You can enable Mobile Lite for your organization by editing your mobile settings.
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Note: Mobile Lite is not supported for Partner Portal users.

About the Default Mobile Configuration
Mobile configurations are sets of parameters that determine the data Salesforce transmits to users' mobile devices and which
users receive that data on their mobile devices. A default mobile configuration is provided so that users can install and run
Mobile Lite without any administrative setup.
The default configuration can mobilize the following objects:
•
•
•
•
•
•
•
•
•
•
•

Accounts
Assets
Cases
Contacts
Dashboards
Events
Leads
Opportunities
Reports
Solutions
Tasks
Note:
•
•

Assets are not available as a tab in the mobile application. Assets display as a related list for accounts, cases, and
contacts.
Dashboards are not available in the Windows Mobile client application.

The default configuration automatically synchronizes records the user recently accessed in Salesforce. Users can search for
records that are not automatically synchronized; once the user downloads a record, the record becomes a permanent part of
the data set.

Enabling Mobile Lite
To enable Mobile Lite for your organization:
1. Click Setup ➤ Mobile Administration ➤ Mobile Settings.
2. Click Edit.
3. Select Enable Mobile Lite to allow users without a mobile license to install and run Mobile Lite, the free, restricted
version of Salesforce Mobile.
Note: If you deselect this option and users are running Mobile Lite, the Salesforce data on their devices will be
erased the next time the devices synchronize with Salesforce.
4. Click Save.
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Installing Mobile Lite
You can install Mobile Lite on BlackBerry, iPhone, and Windows Mobile devices. Not all models can run Mobile Lite, so
review the list of supported devices before installing the application.
To install Mobile Lite on a BlackBerry smartphone:
1. Open your Web browser and navigate to the following URL: mobile.salesforce.com. If you received a Salesforce
Mobile email message from your Salesforce administrator, you can also click the download link in the message.
2. Highlight the Click here to download the client link and select Get Link from the menu.
3. Click Download to download the application. If prompted to replace an older version of the client application, click Yes.
4. Click Reboot to restart your device.
5. When prompted to allow an HTTP connection, select the tp.mobile.salesforce.com checkbox. Scroll down and
click Allow this connection.
6. Click the Salesforce Mobile icon, which resides on the home page of your device or in the Applications folder. On newer
phones, the icon may be in the Downloads folder.
7. Read the license agreement and click I Accept.
The Activation page appears.
8. Enter your Salesforce username and password.
Because many passwords contain special characters that are difficult to enter on the device, the Show Password checkbox
is selected by default. To protect your password, deselect the option. An asterisk displays for each character you type.
9. Open the menu and select Activate to verify your Salesforce account and activate the mobile application on the device.
After your username and password are confirmed by Salesforce, the data is downloaded, and the icon pulses to show activity.
The initial data download may last a few minutes. Future updates to the data automatically occur behind the scenes.
To install Mobile Lite on a Windows Mobile device:
1. Open the email message from your Salesforce administrator in Outlook Mobile. If you don’t receive an email with a link
to the Installer, open Internet Explorer and navigate to the following URL: mobile.salesforce.com.
2. Follow the link in the email on your device to open the Web page for the installer. Your device must be connected to the
network to open the link in the email message.
Note: The installation process for Windows Mobile requires that you use Internet Explorer as the browser.

3. Download the installer.
If your phone has a touch screen:
a. Tap the Click here to download the loader link.
b. Verify that the Open file after download checkbox is selected in the Download dialog.
c. Select Yes.
If your phone does not have a touch screen:
a. Select Download, then select Yes.
b. After the application downloads, select Done.
4. Return to the phone's home page. From the Start menu, select Salesforce Mobile from the list of installed programs.
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5. Read the license agreement and select I Accept.
6. Enter your Salesforce username and password.
7. Select Activate to verify your Salesforce account and activate the mobile application on the device.
After your username and password are confirmed by Salesforce, the data downloads, and the icon pulses to show activity.
The initial data download may last a few minutes. Future updates to the data occur automatically.
8. After your records have been downloaded to the device, the login screen appears. The mobile application remembers your
username and only prompts you for your password. Enter your password, and select Login.
To install Mobile Lite on an iPhone or iPod touch:
1.
2.
3.
4.
5.
6.

From the Home screen of your iPhone or iPod touch, tap the App Store icon.
Tap Search.
Tap the Search field to open the keyboard. Type salesforce.
Tap Salesforce Mobile in the list of search results.
Tap Salesforce Mobile to view information about the application.
Tap Free, and then tap Install.
Note: It does not cost money to download the application from the App Store. Enterprise, Professional, Unlimited,
and Developer Edition users with mobile licenses can run Salesforce Mobile, the full version of the mobile
application. Users without a mobile license can run Mobile Lite, the free, restricted version of the mobile application.

7. Enter your iTunes Store account and password and tap OK.
After you begin downloading the mobile application, its icon appears on your Home screen and shows the status of the
download and installation.
8. The first time you launch the mobile application on your device, you must activate your Salesforce account by logging in
and downloading data. Verify that your phone is connected to a network. For greater performance and reliability, use a
Wi-Fi network instead of a cellular network when activating the mobile application.
9. Tap the Salesforce icon on the Home screen.
10. Tap I Accept.
11. On the activation screen, enter your Salesforce username and password. Tap Done to close the keyboard.
12. Tap Activate.
Caution: Do not close the window or let the device lock. If the application closes, the iPhone operating system
stops the application from running, which causes the activation to fail.
13. The application opens after Salesforce accepts your username and password and downloads your records.

Cloning Records for BlackBerry and iPhone
Summer '09 extends a time-saving sales automation feature to the iPhone and BlackBerry client applications. With the Clone
feature, mobile users can work more efficiently by creating new records based on the details of an existing record.
To clone a record in the BlackBerry application:
1. Highlight a record in the list view. You can also open the detail page.
2. Open the menu and select Clone.
3. Make changes to the record.
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4. Select Save from the menu.
To clone a record in the iPhone application:
1.
2.
3.
4.
5.

Select an object to open the list view.
Tap the record name.
Tap Clone on the toolbar.
Make changes to the record.
Tap Save.

Logout Feature for BlackBerry and iPhone
Summer '09 brings a data security enhancement to the BlackBerry and iPhone client applications. To protect sensitive data
in Salesforce Mobile, users can manually log out.
To sign out of the BlackBerry application:
1. Open the main menu.
2. Select Log Out.
To sign out of the iPhone application:
1. Tap More, then tap App Info.
2. Tap Log Out.
To access the application again, open Salesforce Mobile and enter your passcode.
Note: If your administrator disabled the session timeout so that the application never logs you out due to inactivity,
the Log Out feature is not available.

Custom Embedded Links to Visualforce and Web Tabs for BlackBerry and
iPhone
In Summer ’09, you can create links from native Salesforce records to custom Visualforce pages or Web tabs within the mobile
client application. With a single click in Salesforce Mobile, users can:
•
•
•
•

View a contact's photo
Read the latest news about a company
Use a custom form
Look up a contact in a social networking site

This feature is available in the client applications that support Visualforce and Web tabs, which currently includes iPhone and
BlackBerry.

Creating Embedded Links
You create an embedded mobile link by building a text formula fields on a standard or custom object. To appear in the mobile
client application, the field must be visible on the page layout. The best practice is to include all embedded links in a separate
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section labeled “Mobile Links” at the bottom of the page layout. There is currently no way to hide these links on the Salesforce
website, but users can collapse the section to keep the links out of the way.
To create an embedded link:
1. Create a custom field by navigating to the fields area of the appropriate object:
•
•

For standard objects, click Setup ➤ Customize, select the appropriate object from the Customize menu, and click
Fields.
For custom objects, click Setup ➤ Create ➤ Objects, and select one of the custom objects in the list.

2. Click New in the Custom Fields & Relationships section of the page.
3. Select Formula, then click Next.
4. Enter the field label.
The field name is automatically populated based on the field label you enter.
5. Select Text, then click Next.
6. In the formula editor, create the link to the custom Visualforce page or external website:
•

•

To create a Visualforce link, type "visualforce:///apex/PageName", and replace PageName with the name of
your Visualforce page. You can append parameters to the string, such as ?contactid=" & Id, in order to pass
information from the record in the client application to the Visualforce page.
To create a Web link, type "weblink:", followed by the URL to which you want the link to point, such as
"weblink:http://www.salesforce.com". You can append parameters to the string in order to pass information
from the record in the client application to the Web page. For example, the following Web link launches a social
networking site from a contact record and performs a search for the contact:
"weblink:http://m.linkedin.com/members?search_term=" &FirstName& "+" &LastName&
"&filter=name&commit=Search"

Note: The client application passes the Visualforce or Web link with all parameters to the embedded browser.
It is up to the website or Visualforce page to interpret any parameters. Be sure to construct your Visualforce
Mobile page to consume any parameters passed in the link.
7. Click Next.
8. Set the field-level security to determine whether the field should be visible or read only for specific profiles, and click Next.
9. Choose the page layouts that should display the field. In the next step, you will customize the layout to change the location
of the field on the page.
10. Click Save.
11. Edit the object's page layout:
•
•

For standard object page layouts, select Setup ➤ Customize, select the object, and choose the Page Layouts link. Click
Edit next to the name of the page layout you want to modify.
For custom object page layouts, select Setup ➤ Create, select the object, and scroll to the Page Layouts section. Click
Edit next to the name of the page layout you want to modify.

12. Drag a Section element from the palette to the page layout and drop it below the existing sections.
13. In the Section Name field, type Mobile Links.
14. Deselect the Edit Page option.
15. Select the 1-column layout, then click OK.
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16. Drag the new text formula field from its current location into the new Mobile Links section.
17. Click Save.

Using Embedded Links in the Client Application
To launch an embedded link in the BlackBerry client application:
1. Open a record and scroll down until you see the link on the detail page.
2. Click the link to load the page in the embedded browser. To navigate, you can use the links on the page.
3. When you are finished working with the page, open the menu and select Close Browser to return to the record detail
page.
To launch an embedded link in the iPhone client application:
1. Open a record and scroll down until you see the link on the detail page.
2. Tap the link to load the page in the embedded browser. To navigate, you can use the links on the page or the navigation
toolbar at the top of the page.
3. When you are finished working with the page, tap Done to return to the record detail page.

Visualforce Mobile JavaScript Library for iBlackBerry and iPhone
In Summer '09, Visualforce developers can take advantage of a new JavaScript library containing commands that trigger actions
in Salesforce Mobile, which helps provide a seamless user experience between Visualforce Mobile pages and the native client
application.
When users fill out a new form or edit a Visualforce page on the device, now Salesforce Mobile can immediately synchronize
data. With a tiny bit of extra code, Visualforce Mobile pages force the mobile application to grab updated records when users
click Save. Previously, one of the limitations of Visualforce Mobile was its inability to immediately affect any local data on
the device.
The actions in the new JavaScript library can be used in any Visualforce page. These commands work on JavaScript-enabled
devices that support both Visualforce. Currently, these devices include iPhones and BlackBerry smartphones. When using the
JavaScript library for pages that display on BlackBerry smartphones, we recommend that version 4.5 or later of the BlackBerry
operating system is installed on the device.
Tip: One of the benefits of using the shared JavaScript library is that you can build one page that works on both
iPhone and BlackBerry operating systems.
To call the functions in the library, you need a small amount of JavaScript code. The functions are:
mobileforce.device.sync()
Forces the mobile client application to synchronize with Salesforce, which updates data records on the device.
mobileforce.device.close()
Closes the embedded browser containing the Visualforce page and returns the user to the originating tab or record.
mobileforce.device.syncClose()
Forces the mobile client application to synchronize with Salesforce and closes the embedded browser containing the
Visualforce page.
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mobileforce.device.getLocation()
Obtains the GPS coordinates of the device's current location.
In your Visualforce pages, use the following static resource to point to the JavaScript library:
<script type="application/x-javascript" src="/mobileclient/api/mobileforce.js"></script>

External websites must include the instance name in the src parameter:
<script type="application/x-javascript"
src="http://na1.salesforce.com/mobileclient/api/mobileforce.js"></script>

List View Enhancements for iPhone
Summer '09 gives iPhone users even quicker access to the most relevant data by delivering two new list view enhancements.
Custom List Views
iPhone users can now select the custom list views their Salesforce administrators created in the Mobile Administration
Console. For example, administrators can create a view that shows all of the accounts in California and displays the
billing city, and that view is accessible in the iPhone application.
For more information about building custom list views, see "Managing Mobile List Views" in the Salesforce online help.
Additional Standard List Views
Now there are more standard list views for opportunities, tasks, and cases in the iPhone application. The new views
show four fields of data, providing deep insight into record details, reducing the need to open the record. For example,
the new opportunity views show the opportunity name, amount, close date, and probability. These new views are grouped
with the other standard and custom list views.
To select a view in the iPhone application:
1. Select an object to open its list view.
2. Tap the name of the current view to open a list of available views for that object. For example, tap My Accounts to open
a list of views for accounts.
3. Tap the name of a view to select it.
The application remembers the view you chose and displays it the next time you select that object.
Tip: Standard views are also available in related lists.

Convert Leads for iPhone
With Summer '09, users can accomplish more away from the office by converting a lead as soon as they hang up the phone.
The iPhone client application now offers lead conversion in a single form.
To convert a lead:
1. Open a lead, then tap Convert Lead on the toolbar.
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2. Optionally, change the owner of the new records. This reassigns all notes, attachments, and open activities to the new
owner but does not change closed activities. Set the Send Email to the Owner option to On to send an automated email
to the new owner.
3. Create a new account or select an existing account.
4. If you are updating an existing person account, select the checkbox if you want to overwrite the Lead Source field in
the person account with the value from the lead.
5. Name the new opportunity, or set the Create New Opportunity option to Off if you do not want to create an opportunity.
6. Select the status for the converted lead. Choices include statuses marked as "converted" by your administrator.
7. Tap Convert.

Calendar-like Event View for iPhone
Summer '09 offers an enhancement to the Events user interface. Now users can browse their events using a calendar-like
interface. They can also use the date-indexed list view to scroll through upcoming events.
The calendar is available from the Events tab. You can view your events in a calendar format or in a list. To change the view,
tap Calendar or List at the top of the Events page. The calendar view displays events one day at a time.
To navigate the calendar:
•
•
•
•
•
•

Tap the Next Month icon to jump ahead one month. Tap the Previous Month icon to go back one month.
Tap the Next Week icon to jump ahead one week. Tap the Previous Week icon to go back one week. You can also swipe
the dates left or right to change the week.
Days with events show a dot below the date. Tap a date to view that day's events.
Tap Today to see today's events.
For each event, you can see the subject, start time, end time, and the name of the record to which the event is related.
To view an event's details, tap the event.

Product and Price Book Support for iPhone
In Summer '09, iPhone users can associate a price book to an opportunity and add products. To mobilize products and price
books, add these objects to the data set of your mobile configuration in the Mobile Administration Console.

Mobilizing Products and Price Books
To mobilize products and price books:
1. Click Setup ➤ Mobile Administration ➤ Mobile Configurations, and click the name of the mobile configuration you
want to modify.
2. In the Data Sets related list, click Edit.
3. Click the Opportunity data set to select it.
Note: If your mobile configuration does not include an Opportunity data set, create one. Select Data Sets, then
click Add.... In the popup window, select Opportunity, then click OK.
4. Click Add... to create a child data set under the Opportunity data set.

19

Salesforce Applications

Salesforce Mobile Enhancements

5. In the popup window, select Opportunity Product, then click OK. Mobilizing the Opportunity Product object under the
Opportunity data set lets the mobile application connect opportunities to products.
6. In the hierarchy, select Data Sets to create a parent data set.
7. Click Add....
8. In the popup window, select Product, then click OK.
9. Optionally, use filters to control which product records synchronize to the device.
10. Click Done.

Choosing a Price Book for an Opportunity
To select a price book in the iPhone mobile client application:
1.
2.
3.
4.

Open an opportunity.
Scroll down and tap the Products related list.
Tap Price Book.
Select a price book.
Note: If you change the price book for an opportunity, all existing products are deleted from the opportunity.

Updated Actions Toolbar for iPhone
In Summer '09, the appearance of the Actions toolbar has been updated. The Actions toolbar on detail pages in the iPhone
application displays a set of actions you can take on the current record. The toolbar displays three buttons at a time. If more
than three actions are available for the current record, flick to scroll the toolbar to reveal additional actions.
Note: The toolbar does not display if you have read-only access to the selected record.

App Info Toolbar for iPhone
To streamline the App Info screen and make it more consistent with the rest of the iPhone application, the App Info buttons
have been relocated to a toolbar.

Schema-Driven Related Lists for iPhone
In Summer '09, the iPhone client application uses the object's page layout to determine which related lists display for a record.
Previously, related lists were based on the lookup fields in the object, not on the object's page layout.

Related Lists on Detail Pages for BlackBerry
Summer '09 offers an interface enhancement to the BlackBerry client application. Now, users can access a record's related
items directly from its detail page. The related lists are still available in the main menu as well.
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To view a record's related items:
1. Open a record.
2. Scroll down to the bottom of the detail page to view the Related Items section, which contains the record's related lists.
3. Select one of the related lists to display the records.

Salesforce to Salesforce Enhancements
Available in: All Editions

Salesforce to Salesforce includes the following enhancements in Summer '09:
Note: Salesforce to Salesforce Summer '09 enhancements will be available at the end of June, 2009.

Automatically Map Fields
Subscribers can now automatically map a connection's fields to their fields.
Auto-Accept Records
You can now specify, by object, if records should be automatically accepted when shared by a connection.
Share Cases
You can now share case records with Salesforce to Salesforce connections.
Share Case Comments
You can now share case comments with Salesforce to Salesforce connections. If you subscribe to the Case Comment
object, public case comments are automatically shared with a connection when you share the associated case.
Publish and Subscribe to Auto Number Fields
You can now publish and subscribe to fields of type auto number. You can map auto number fields to any text field that
has a length greater than 30 characters.

About Salesforce to Salesforce Enhancements
Automatically Map Fields
Subscribers can now automatically map a connection's fields to their fields by selecting the Automatically map fields
checkbox on the Edit Subscribed Fields page. To automatically map your fields with your connection's fields:
1. Click the Connections tab.
2. Click the name of the connection you want to modify.
3. In the Subscribed Objects related list, click Edit next to the subscribed object.
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4. Select Automatically map fields to automatically map your business partner's fields to your fields. For any unmapped
field, Salesforce checks if the field's API name matches that of any of your fields. If there are no matches, Salesforce then
checks for matching field labels. If Salesforce still cannot find a match, --None-- is selected.
Note: Selecting Automatically map fields does not overwrite previous selections. Deselecting the checkbox
does not affect fields that were mapped in a previous transaction.
Changes that result from selecting this checkbox are not applied until you click Save.
For more information, see "Subscribing to Fields in Salesforce to Salesforce" in the Salesforce online help.

Auto-Accept Records
With Summer '09, subscribers can now specify, by object, to automatically accept records when shared by a connection. Prior
to this release, subscribers were required to manually accept shared records one at a time; a time-consuming activity if a
connection shares a large volume of records. To auto-accept records from a connection:
1.
2.
3.
4.

Click the Connections tab.
Click the name of the connection you want to modify.
In the Subscribed Objects related list, click Subscribe/Unsubscribe.
Select the Auto-Accept checkbox next to an object if you want to automatically accept records of that type when shared
by your connection. The checkbox appears once you select a mapping.
Note: This checkbox is not available for:
•
•

Child objects, such as opportunity products, tasks, and case comments. Child objects are automatically accepted
when the parent record is accepted.
Objects that have one or more master objects, such as custom junction objects or detail objects in a master-detail
relationship.

Additionally, Auto-Accept does not apply to any record that is shared as the child of another record, for example
a case record that is the child of a case record that you already accepted.

Additional Considerations
•
•
•

Auto-Accept does not apply to accounts if either the organization publishing the account record or the organization
subscribing to the record has been enabled for Person Accounts. The shared account record must be manually accepted.
If you choose to auto-accept leads or cases, any active assignment rules in your organization run when a record is automatically
accepted.
In order to automatically accept a record shared by your connection, the connection owner for that record must be an active
user.

Sharing Cases and Case Comments
You can share case records with one or more business partners with whom you have a connection.
Note: You can only forward records that you or your subordinates own; System Administrators can forward all records.
You cannot forward a record for a custom object that has not been deployed.
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To forward a single case and its related records to one or more connections:
1.
2.
3.
4.

View the record's detail page.
In the External Sharing related list, click Forward this Case.
Select the connection(s) that you want to forward the record to in the Available Connections list.

Click the Add arrow ( ) to move the connection(s) to the Selected Connections list.
5. Optionally select Send Notification Email (new invitees only) to send an email notifying the connection's representative
that you have forwarded the record to them. Only new recipients of the record will receive the notification email. Connections
that you previously forwarded the record to will not receive another email.
6. Optionally select the checkboxes next to related records you want to forward with the master record.
7. Click Save.
Sharing Case Comments with Connections
You can share a case comment as a child record of a case. Case comments will be automatically accepted by a connection,
providing the following criteria are met:
•
•
•

The Case Comment object type must be published to your connection, and your connection must be subscribed to the
object.
The case to which the case comment is associated must be shared with the connection.
The case comment must not be marked "Private."

Tips
•

To automatically assign all incoming leads or cases to a specific user, create an assignment rule that includes the following
rule entries:
-

•

Received Connection Name contains name of connection
Created By contains Connection User

You can do the same with escalation rules.
If you want to assign a case to a connection using an escalation rule on the case, you must assign the case to a queue where
the connection is a member. For example, if you have a connection that acts as your third-party service agency and all cases
meeting certain criteria should be escalated to this connection, you must:
-

Create a queue that contains the connection as a member.
Create an escalation rule with the appropriate criteria.
Add an escalation action that automatically assigns cases meeting the specified criteria to that queue

Automated Campaigns
Available in: Enterprise, Unlimited, and Developer Editions
Available for an additional cost in: Professional Edition

Summer '09 introduces several major enhancements to campaign members to enable automated campaigns, including:
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Workflow
You can configure workflow rules for campaign members, including email alerts to leads, contacts, or internal users; field
updates; and time-triggered email alerts and field updates. You can create automated campaign actions using workflow
rules, for example, to send an agenda to an event attendee when the Status field on their campaign member record equals
Responded. To configure workflow rules, click Setup ➤ Create ➤ Workflow & Approvals ➤ Workflow Rules. For
more information, see "Creating Workflow Rules" in the Salesforce online help.
Campaign Member Fields in Email Templates
You can use campaign member fields as merge fields in email templates. To set up email templates, click Setup ➤
Communication Templates ➤ Email Templates. For more information, see "Managing Email Templates" in the
Salesforce online help.
Apex Triggers
You can define Apex triggers associated with campaign members. For example, you can set a trigger to clone a campaign
member to a campaign called High Priority Responses if their score in a campaign member custom field called Response
Score is higher than 25. To set up triggers, click Setup ➤ Customize ➤ Campaigns ➤ Campaign Members ➤ Triggers.
For more information, see "Managing Apex Triggers" in the Salesforce online help.
Custom Fields
You can create custom fields on campaign member records. For example, you can create custom fields to track event-specific
responses like RSVP status, seating charts, or food preferences. Your organization can create up to 500 custom fields.
You can include campaign member custom fields in reports.
To configure campaign member custom fields, click Setup ➤ Customize ➤ Campaigns ➤ Campaign Members ➤
Fields. For more information, see "Custom Fields" in the Salesforce online help.
Campaign Member Detail Page
From the new Campaign Member detail page, you can view, edit, delete, or clone a campaign member record. Additionally,
for a campaign member created from a lead, you can convert the lead to a new or existing account, contact, and optionally,
opportunity. For a campaign member created from a contact, you can create an opportunity.
Campaign Member Detail Page Layout
You can edit the Campaign Member detail page layout using the page layout editor. You can customize the Campaign
Member detail page to include standard fields derived from lead and contact records, and you can add or remove buttons.
Related lists and lookups to campaign member fields are not supported on the Campaign Member detail page layout.
To edit the Campaign Member detail page layout, click Setup ➤ Customize ➤ Campaigns ➤ Campaign Member
➤ Page Layouts. If you create multiple layouts, the layout displayed is controlled by the profile of the logged in user.
For more information, see "Customizing Page Layouts" in the Salesforce online help.
Field-Level Security
You can configure field-level security for standard fields on campaign member records. To configure field-level security,
click Setup ➤ Customize ➤ Campaigns ➤ Campaign Members ➤ Fields then click the field you want to configure.
Alternatively, you can click Setup ➤ Security Controls ➤ Field Accessibility, then click Campaign Member. For
more information, see "Setting Field-Level Security" in the Salesforce online help.
Validation Rules
You can define validation rules to validate data on campaign member records. To set up validation rules, click Setup ➤
Customize ➤ Campaigns ➤ Campaign Members ➤ Validation Rules. For more information, see "Managing Validation
Rules" in the Salesforce online help.
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Buttons and Links
You can configure custom buttons and links on campaign member records. To configure custom buttons and links, click
Setup ➤ Customize ➤ Campaigns ➤ Campaign Members ➤ Buttons and Links. For more information, see "Setting
Custom Buttons and Links" in the Salesforce online help.
Data Export
You can manually export campaign member data or schedule automatic data exports. For more information, see "Exporting
Backup Data" in the Salesforce online help.
CampaignMember API Enhancements
See CampaignMember in the Changed Objects section under Force.com Web Services API Enhancements.

About Automated Campaigns
Displaying and Editing a Campaign Member
Available in: Enterprise, Unlimited, and Developer Editions
Available for an additional cost in: Professional Edition

User Permissions Needed
To view, edit, or remove campaign members:

"Read" on campaigns
AND
"Read" on leads
AND
"Read" on contacts

To add campaign members:

"Read" on campaigns
AND
"Edit" on leads
AND
"Edit" on contacts

From the campaign member detail page, you can edit, delete, or clone a campaign member record. Additionally, if the campaign
member is based on a lead, you can convert the lead; if the campaign member is based on a contact, you can create an opportunity.
To view the campaign member detail page, click the campaign member's name in the Name, First Name, or Last Name
columns on the Campaign Members related list on a campaign detail page or on the Existing Members tab. To view a campaign
member, you must have a combination of permissions on the campaign and the lead or contact. For example, to view a campaign
member that was created from a lead, you must be able to view both the campaign and the lead.
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To edit the campaign member detail page layout, click the Edit Layout link or click Setup ➤ Customize ➤ Campaigns ➤
Campaign Member ➤ Page Layouts.
Editing a Campaign Member
To edit a campaign member, click Edit on the campaign member detail page, change the fields you want to update,
then click Save. Fields derived from the contact or lead can only be edited from the lead or contact detail pages.
Note: If your administrator has enabled inline editing for your organization, you cannot use inline editing on
the Status drop-down list on the campaign member detail page. Instead, click Edit on the campaign detail
page to edit the Status drop-down list.
Cloning a Campaign Member
To clone a campaign member, click Clone on the campaign member detail page, then select a campaign and a contact
or lead. Change the fields you want to clone for the new campaign member, then click Save.
Deleting a Campaign Member
To delete a campaign member, click Delete on the campaign member detail page.
Note: Deleting a campaign member record is permanent; the record is not recoverable from the recycle bin.
However, the original lead or contact record is not deleted.

Converting a Lead
If the campaign member was created from a lead, you can click Convert Lead on the campaign member detail page to
convert the lead. When you convert a lead, the campaign member is still a part of the campaign, but the campaign
member type changes from lead to contact.
Creating an Opportunity
If the campaign member was created from a contact, you can click Create Opportunity on the campaign member detail
page to create an opportunity. When you create an opportunity, the campaign member is still a part of the campaign.

Campaign Member Fields
The available fields vary according to which Salesforce Edition you have.

These are the fields (in alphabetical order) that make up a campaign member. Most campaign member fields are derived from
the lead or contact record from which the campaign member was created and must be edited from the corresponding lead or
contact record. Some of these fields may not be visible or editable depending on your page layout and field-level security
settings. (Field-level security is available in Enterprise, Unlimited, and Developer Editions only.)
Field

Description

Campaign

The campaign to which the lead or contact belongs.

City

City portion of the lead or contact's address.
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Field

Description

Company (Account)

The company, if the campaign member is based on a lead, or the account, if the campaign
member is based on a contact.

Contact

The name of the contact, if the campaign member is based on a contact.

Country

Country portion of the lead or contact's address.

Created By

User who created the campaign member. (Read only)

Created Date

Date the campaign member was created. (Read only)

Currency

The corporate currency for your organization. This field only displays in organizations
with multiple currencies enabled. (Read only)

Description

Description of the lead or contact.

Do Not Call

Indicates if the person does not want to be contacted via telephone.

Email

Email address of the lead or contact.

Email Opt Out

The person's email address will not be included in mass emails.

Fax

Fax number of the lead or contact.

Fax Opt Out

Indicates if the person has requested not to be included in broadcast faxes.

First Name

First name of the lead or contact.

First Responded Date

Date the campaign member first responded. (Read only)

Last Modified By

User who last changed the campaign member record. (Read only)

Last Modified Date

Date the campaign member record was last modified. (Read only)

Last Name

Last name of the lead or contact.

Lead

The name of the lead, if the campaign member is based on a lead.

Lead Source

Source of lead, for example, Advertisement, Partner, or Web. Entry is selected from a
picklist of available values, which are set by an administrator. Each picklist value can have
up to 40 characters.

Mobile

Mobile phone number for the lead or contact.

Phone

Phone number for the lead or contact.

Responded

Indicates if the campaign member has responded.

Salutation

The salutation for addressing the person, for example, Mr., Ms., Dr., or Prof.

State/Province

State or province portion of the lead or contact's address.

Status

The status of the campaign member, for example, sent or responded.

Street

State portion of the lead or contact's address.

Title

The title of the lead or contact, for example, President.

Zip/Postal Code

Zip or postal code portion of the lead or contact's address.
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Generic From Email Address Support
Available in: All Editions

Summer '09 introduces the ability for users to send email through Salesforce using a common email alias called an
organization-wide address. Organization-wide addresses allow you to associate a single email address as an alias for all users
within a particular profile. When you create an organization-wide address, you can define a From address and a Display
Name different than the ones defined in your email settings.
For example, assume your organization has several users under a single Support Profile. A Support Profile can be associated
with an email address called support@acme.com and a Display Name of Acme Support. When Support Profile users
send an outbound email through Salesforce, they can choose to have their From address appear as support@acme.com
instead of their own Salesforce email address.
The highlighted sections in the following image represents the changes to the From address and Display Name that the
recipient of an email might see:

Implementation Tips
•
•
•
•
•

Organization-wide addresses are not available when sending a mass email or a Stay-in-Touch request.
The maximum length for the Display Name is 300 characters.
The defined From address must be in a valid format. The maximum length for the email address is 270 characters. Before
you are able to use the organization-wide address, a verification email is sent to the new address.
A new, optional argument, OrgWideEmailAddressId, has been added to the SingleEmailMessage API object. For
more information, see Using the Force.com API with an Organization-Wide Address on page 29.
In Apex, Messaging.SingleEmailMessage has been extended to permit an organization-wide address for outbound
messages. For more information, see Using Apex with an Organization-Wide Address on page 30.

About Organization-Wide Addresses
Defining Organization-Wide Addresses
User Permissions Needed
To configure organization-wide addresses:

"Modify All Data"

To define an organization-wide address for a user profile:
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1. Click Setup ➤ Email Administration ➤ Organization-Wide Addresses.
2. Click Add.
3. Enter a Display Name. The display name identifies how your name appears on outbound emails. The maximum length
is 300 characters.
4. Enter the Email Address you would like to use as an alias. This can be any standard email address. The maximum length
is 270 characters.
5. Select Allow All Profiles to Use this From Address if you want every user profile in your organization to
be able to use the new From address. Otherwise, select Allow Only Selected Profiles to Use this From
Address to choose from existing user profiles.
6. Click Save to save your changes, or Save and New to define another organization-wide address. A verification email is
sent to the new email address which includes a link that you click to complete the verification process. The From address
will not be available for use until you access the email and click this link. Click Cancel to return to the previous page
without saving.

Using Organization-Wide Addresses
You can use an organization-wide address any time you send email to a contact, lead, person account, or other user:
1. Click Send An Email on the Activity History related list of a record. Or, from a case, click Send An Email or Reply from
the Email related list. This option is available only to organizations using Email-to-Case or On-Demand Email-to-Case.
2. You can specify the sending address of the email from the From drop-down list. Any previously defined organization-wide
addresses associated with your user profile will appear in this drop-down list.
3. Complete the remaining fields. When you send the email, your From address and Display Name will be set to the
organization-wide address you defined. The recipient of the email will reply directly to the organization-wide address.
For more information about sending email, see "Sending Email" in the Salesforce online help.

Using the Force.com API with an Organization-Wide Address
The following fields are available for the new OrgWideEmailAddress API object:
Field

Field Type

Field
Description
Properties

Address

string

Create

The organization-wide email address.

Filter
Update
IsAllowAllProfiles

boolean

Create

If true, any user profile in your organization can use this
object. If false, only specified user profiles can use this
Defaulted
object when sending email. If you do not have the appropriate
on create
user profile, you cannot use this object.
Filter
Update
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Field

Field Type

Field
Description
Properties

DisplayName

string

Create

The name that is used to identify the sender of the email.

Filter
Update

A new, optional argument, OrgWideEmailAddressId, has been added to the SingleEmailMessage object.
OrgWideEmailAddressId is an object ID to an existing OrgWideEmailAddress object. If OrgWideEmailAddressId
is set, the OrgWideEmailAddress.DisplayName field is used in the email header, instead of the logged-in user's Display
Name. The sending email address in the header is also set to the field defined in OrgWideEmailAddress.Address.
Note: If both the DisplayName and senderDisplayName are defined, the user receives a
DUPLICATE_SENDER_DISPLAY_NAME error.
For more information, see sendEmail() in the Force.com API Developer's Guide.

Using Apex with an Organization-Wide Address
A new method, setOrgWideEmailAddressId, has been added to the SingleEmailMessage object. If
setOrgWideEmailAddressId is passed a valid OrgWideEmailAddress ID, the OrgWideEmailAddress.DisplayName
field is used in the email header, instead of the logged-in user's Display Name. The sending email address in the header is
also set to the field defined in OrgWideEmailAddress.Address.
Note: If both the OrgWideEmailAddress.DisplayName and setSenderDisplayName are defined, the user
receives a DUPLICATE_SENDER_DISPLAY_NAME error.
For more information, see Outbound Email in the Force.com Apex Code Developer's Guide.

Additional Salesforce Application Enhancements
Activities Enhancements
Available in: All Editions

Recurring Tasks
You can now create tasks that repeat on a daily, weekly, monthly, or yearly basis by selecting the Create Recurring
Series of Tasks checkbox when creating a task.
Recurring Event Enhancements
To make editing and creating recurring events consistent with how you create and edit recurring tasks, the following
enhancements are now available:
•

When creating a recurring event, you can now click Calculate max end date to automatically set the maximum end
date allowed based on the frequency you selected.
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To make it easier to edit all the occurrences in an event series, you can now click Edit Series in the Recurrence
section on the Event Detail and Event Edit pages.
It is now easier to set a reminder for an all-day recurring event that is relative to the date of each event in the series
(for example, setting a reminder one day before, two days before, one week before, etc.). You now use a drop-down
list to specify the relative reminder date instead of a calendar pop-up that was used previous versions.

Contact Manager Edition
In Summer '09, Salesforce introduces the new Contact Manager Edition.
Contact Manager is designed for small businesses and provides access to key contact management features including accounts,
contacts, activities, calendars, notes and attachments, and reports. Contact Manager also provides straightforward and easy-to-use
customization options.
Content Delivery Password Protection
Available in: All Editions
In Summer '09, Salesforce offers password protection for content deliveries. On the Setup ➤ Customize ➤ Content Deliveries
➤ Settings page, administrators can make passwords required or optional. Depending on this setting, the Require Password
to Access Content option in the create-delivery wizard is checked or unchecked by default. If a password is required or
the user chooses to generate a password, Salesforce provides the password with the content-delivery URL so the user can send
the password and URL to the content-delivery recipient. The password is also available on the delivery details page for easy
reference. To view the delivery details page, open the content details page and click Deliver Content ➤ Show my deliveries.
A list view displays showing all content deliveries created for that file. Click a delivery name to view its delivery details page.
Salesforce CRM Content Enhancements
Available in: Professional, Enterprise, and Unlimited Editions

Additional Options in Salesforce CRM Content Reports
Summer '09 adds new report fields to Salesforce CRM Content custom reports. You can now report on ratings data,
which includes thumbs-up votes, thumbs-down votes, and overall ratings. You can also report on featured content. To
generate a report that includes any of these fields, go to the Reports tab and choose Create New Custom Report ➤
Salesforce CRM Content ➤ Content Report.
Enable or Disable Content Packs and Presentations
To provide more granular control over feature visibility in your organization, Summer '09 allows administrators to disable
the content pack and content presentation features introduced in Spring '09. Click Setup ➤ Customize ➤ Salesforce
CRM Content and toggle the Enable content pack creation or Enable presentation assembly checkboxes
as needed. By default, both settings are enabled in new organizations.
When these settings are enabled, the Create New ➤ Content Pack and Create New ➤ Presentation options display
on the Workspaces tab. Also, from the content details page, users can clone and customize these documents or create
new versions. If you disable Enable content pack creation or Enable presentation assembly after users
in your organization have already created content packs or presentations, no content is deleted and users can continue
to modify metadata such as description, title, and custom fields. However, once content pack creation or presentation
assembly is no longer enabled, users cannot customize or modify existing packs or presentations. Specifically, the Clone
& Customize button and the Edit ➤ Content Pack or Edit ➤ Presentation options on the content details page are
unavailable.
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Customer Portal and Partner Portal Administration Tools
Customer Portal is available in: Enterprise, Unlimited, and Developer Editions
Partner Portal is available in: Enterprise and Unlimited Editions

Automatically Exclude Portal Users from Folders
Folders allow you to arrange reports, dashboards, and documents according to your business needs. You can restrict
access to folders based on a user's position in the role hierarchy or membership in a public group. Because Customer
Portal and Partner Portal users appear in the role hierarchy but are external contacts who should not have access to your
organization's internal data, you must configure your organization's folders to prevent inappropriate access by portal
users.
Now, when you set up a Customer Portal or Partner Portal, you can use the Convert Portal User Access wizard to help
ensure that no report, dashboard, or document folder is shared with a portal user. This is more efficient than manually
locating various folders and setting their access levels individually.
Previously, this wizard was named the Convert Roles and Subordinates Sharing Rule Category wizard, and it allowed
you to convert sharing rules from Roles and Subordinates to Roles and Internal Subordinates. Similar functionality now
extends to folders: you can convert folders accessible to Roles and Subordinates to folders that are accessible to Roles
and Internal Subordinates.
To use the wizard:
1. For the Customer Portal, click Setup ➤ Customize ➤ Customer Portal ➤ Settings. For the Partner Portal, click
Setup ➤ Customize ➤ Partners ➤ Settings.
2. Click the Convert Portal User Access link.
3. Select the checkboxes next to the sharing rules you want to convert to Roles and Internal Subordinates.
If there are no sharing rules to convert but you want to convert the access level for folders, proceed to the following
step.
4. Click Next.
5. Select the checkboxes next to the folders whose access levels you want to change to Roles and Internal Subordinates.
The wizard does not convert folders that are accessible to all users or accessible to public groups. You must manually
update the access levels on those folders.
A particular folder may display on multiple rows in the wizard. This is because the wizard displays a row for each
Role and Subordinates category to which a folder is shared.
6. Click Next.
7. Click Save to apply your selected changes.
Tips on Excluding Portal Users from Folders
•
•

•
•
•

You need the "Manage Users" permission to use the wizard.
The wizard does not convert folders that are accessible to all users or accessible to public groups. You must
manually update the access levels on those folders. For more information, see "Creating and Editing Folders"
in the Salesforce online help.
A particular folder may display on multiple rows in the wizard. This is because the wizard displays a row for
each Role and Subordinates category to which a folder is shared.
When you first save a Customer Portal or Partner Portal, Salesforce automatically displays the Convert Portal
User Access wizard.
For more information, see "About the Convert Portal User Access Wizard" in the Salesforce online help.
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Disabling and Deactivating Portal Users
Now, there are two ways in which users with the "Edit Self-Service Users" or "Manage Users" permissions can remove
a portal user's access to your Customer Portal or Partner Portal. As described in detail below, disabling a portal user is
permanent, while deactivating a portal user is not:
Disabling a portal user
Disabling a portal user includes the following actions:
•
•
•

Termination of the user's access to your portal
Removal from all groups, teams, and sharing rules with which the user is associated.
Permanent loss of the portal user's association with the contact
If you later re-enable a contact for portal access, a new portal user is created that is not related to the previous
portal user record in any way.

We recommend disabling a portal user if:
•
•
•

A contact was accidentally enabled as a portal user
The portal user is associated with a duplicate contact
You do not want a contact to access the portal in the future
Note: Salesforce does not delete user records, including portal user records. While you cannot re-enable
a disabled portal user, you can view and update the record for a disabled user by clicking Setup ➤ Manage
Users ➤ Users.

Deactivating a portal user
Deactivating a portal user prevents that user from logging into your portal and gives you the option to remove the
user from any teams in which he or she is a member (for example, case teams and account teams). When you
deactivate a portal user, the portal user record does not permanently lose its association with the contact. You can
reactivate the portal user at any time.
Note: When a delegated portal user administrator deactivates a portal user, the administrator does not
have the option to remove the portal user from any teams on which that user is a member.

We recommend deactivating a portal user if you may reactivate the portal user in the future.
To Disable a Portal User
1. On the contact detail page, click either Disable Customer Portal User or Disable Partner User. On the account
detail page of a person account, click Disable Customer Portal Account.
Person accounts are not available for the Partner Portal.
2. Click OK.
To Deactivate a Portal User
1. For the Customer Portal, click the View Customer Portal User button on the contact or person account detail
page. For the Partner Portal, click the View Partner User button on the contact detail page.
Person accounts are not available for the Partner Portal.
2. Click Edit, and deselect the Active checkbox.
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To reactivate a portal user at any time, select the Active checkbox.
3. Click Save.
Tips on Disabling and Deactivating Portal Users
Consider the following when disabling or deactivating portal users (disabling is permanent; deactivating is not):
•
•

•
•

•

•
•

•

•

You cannot delete an active portal user; you can only disable or deactivate his or her access to the portal.
The following table describes whether you can delete contacts that are associated with portal users:
State of Portal User Associated to Contact

Can Delete Contact?

Active portal user

No. This is to ensure that the contact is available if
you choose to reactivate the portal user.

Inactive portal user

No. This is to ensure that the contact is available if
you choose to reactivate the portal user.

Disabled portal user

Yes. Deleted contacts are sent to the Recycle Bin.

To delete a portal-enabled contact, first disable the portal user, then delete the contact.
Cases associated with a portal user are not updated in any way when you disable or deactivate the portal user.
For example, if a portal user owns a case, and the portal user is disabled, he or she remains the owner of the
case until the case is updated with a new owner.
Before you disable a partner user, we recommend that you transfer any opportunities owned by the user to
another user who will remain active. This is because when you disable a partner user, any opportunities he or
she owns are removed from your organization's forecast hierarchy (the partner user's role becomes obsolete).
After you disable a portal user, it may take Salesforce up to ten seconds to disable the user. During that time,
a portal user may still perform actions on a portal.
You can remove the Disable Customer Portal and Disable Partner User buttons from contact page layouts
at any time. Doing so would prevent users with the "Edit Self-Service Users" or "Manage Partners" permissions
from disabling portal users.
A disabled or deactivated portal user does not count against your organization's available user licenses. However,
disabling or deactivating a portal user does not reduce the number of licenses for which your organization is
billed; you must change your organization's license count to change your billing. See "Adding or Subtracting
User Licenses" in the Salesforce online help.
To disable all portal users associated with an account and permanently delete all of the account's portal roles
and groups:
-

Click Disable Partner Account on a Partner Portal account.
Click Disable Customer Portal Account on a Customer Portal account or Customer Portal person account.

You can remove the Disable Customer Portal Account and Disable Partner Account buttons from account
page layouts at any time. Doing so would prevent users with the "Edit Self-Service Users" or "Manage Partners"
permissions from disabling portal accounts.
•
•

When you disable a portal user or portal account, the change is tracked in the setup audit trail.
Portal roles are not removed from disabled portal users associated with person accounts. However, you can
remove the portal roles manually:
1. Click Setup ➤ Manage Users ➤ Users.
2. Select the name of a disabled portal user.
3. Click Edit.
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4. Select None from the Role drop-down list.
5. Click Save.

Disabling Portal Accounts
Now, users with the appropriate permissions can disable up to 15 Partner Portal portal users and up to 100 Customer
Portal users associated with an account and permanently delete all of the account's portal roles and groups. Disabling a
portal account is the quickest way to remove all portal users, roles, and groups from an account that you may have
accidentally granted portal access.
Disabling Partner Portal Accounts
On an account detail page, click Disable Partner Account.
Disabling Customer Portal Accounts
On an account or person account detail page, click Disable Customer Portal Account.
Tips on Disabling Portal Accounts
•
•

You cannot restore deleted portal roles and groups.
Users need the following permissions to disable portal accounts:
-

•

•

•
•

To disable a Partner Portal account: "Manage Partners" and "Edit" on accounts
To disable a Customer Portal account: "Edit" on accounts and "Edit Self-Service Users"

After you disable a portal account, you can re-enable individual contacts as portal users. However, re-enabling
a contact for a portal creates a new portal user and role that is not associated with the previous portal user and
role in any way. For more information, see "Enabling the Customer Portal for Contacts and Person Accounts"
in the Salesforce online help and "Creating Partner Users" in the Salesforce online help.
You can remove the Disable Customer Portal Account and Disable Partner Account buttons from account
page layouts at any time. Doing so would prevent users with the "Edit Self-Service Users" or "Manage Partners"
permissions from disabling portal accounts.
When you disable a portal account, the change is tracked in the setup audit trail. For more information, see
"Monitoring Setup Changes" in the Salesforce online help.
For more information on disabling portal accounts, see:
-

Disabling and Deactivating Portal Users on page 33
"Displaying and Editing Accounts" in the Salesforce online help

Transfer Portal-Enabled Contacts Between Accounts
Now, when portal-enabled contacts move between companies, users can reassign contacts to the appropriate accounts.
To change accounts on portal-enabled contacts, users need the "Edit" permission on contacts and the "Edit Self-Service
Users" or "Manage Partners" permission.
To update accounts on a contacts enabled to use a Partner Portal or Customer Portal:
1.
2.
3.
4.

Select a contact from the Contacts tab.
Click Edit.
Change the account in the Account Name field.
Click Save.

When you change the account on contacts enabled for a portal:
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Portal users can access their own cases and opportunities from their previous accounts.
If the contact is a Self-Service user, he or she can only view cases on the Self-Service portal that are associated with
their current account. Self-Service users cannot view opportunities.

•

•

Contacts' portal roles are automatically updated to match the name of the account to which they are transferred. For
example, the portal role "Account A Customer User" becomes "Account B Customer User." This is because the
name of a portal role includes the name of the account with which it is associated. Portal roles are unique to each
account and are located under the account owner's role in your organization's role hierarchy.
When you transfer a Partner Portal user to another account:
-

•
•

The opportunities on each account are automatically recalculated through your organization's forecast hierarchy.
Any opportunities owned by the Partner Portal user remain in the previous account.

This is because portal users' roles are updated when you transfer them between accounts.
Delegated partner user administrators and delegated Customer Portal user administrators can update portal users on
any account to which they are transferred.
You can only transfer contacts enabled for a Partner Portal to accounts that are enabled for a Partner Portal.

Merge Portal-Enabled Contacts
Now, you can merge contacts enabled to use:
•
•
•

A Partner Portal or Customer Portal.
A Partner Portal with contacts enabled to use a Customer Portal or vice-versa.
A Partner Portal or Customer Portal with contacts that are not enabled to use a portal.

This enables you to remove duplicate contacts from Salesforce and improve the quality of your data.
To merge portal-enabled contacts:
1. From the Contacts related list of an account, click Merge Contacts.
2. Check the rows of up to three contacts you want to merge. You can search the list of associated contacts to shorten
the list, or click All Contacts to view the full list of associated contacts. Click Next to continue.
3. Select one contact as the Master Record. Any data in hidden or read-only fields will be taken from the Master Record.
However, administrators, and users with the “Edit Read Only Fields” permission, can manually select which read-only
fields to retain. Note that hidden fields are not displayed.
4. Select the Partner Portal or Customer Portal user you want to retain.
This option is only available if a Partner Portal or Customer Portal is enabled for your organization.
You can select Not a portal user so that a merged contact does not include a portal user.
5. Select the fields that you want to retain from each record.
When there is conflicting data, the fields in the left column are preselected and the row is marked in purple.
6. Click the Merge button to complete the merge.
Tips on Merging Portal-Enabled Contacts
•
•
•
•

To merge Customer Portal enabled contacts, users need the "Delete" permission on contacts and the "Edit
Self-Service Users" permission.
To merge Partner Portal enabled contacts, users need the "Delete" permission on contacts and the "Manager
Partners" permission.
Any related items from any of the duplicate contacts will be associated with the merged contact.
All discarded duplicate records are moved to the Recycle Bin.
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The newly merged contact displays the Created By date from the oldest contact you are merging, and shows
the merge date as the Modified By date.
When merging a contact and a contact with a portal user, you can select Not a portal user so that the
merged contact does not include a portal user.
When you merge contacts that include Partner Portal and Customer Portal users, you must choose which type
of portal user to retain. The portal user you do not retain is disabled. However, after the contacts are merged,
you can enable the contact for access to the portal from which you removed during the merge process.
Merging contacts is not tracked in the setup audit trail.
To merge contacts associated with various accounts:
1. Transfer the contacts you want to merge into one account.
2. Merge the contacts associated with the common account.

•

•

Portal users who are disabled during the merge process retain ownership of any records in which they are the
owner. For example, if a portal user owns a case, and the portal user is disabled, he or she remains the owner
of the case until the case is updated with a new owner.
For more information, see "Merging Duplicate Contacts" in the Salesforce online help.

Remove the Submit & Add Attachment Button from the Customer Portal
Now, users with the "Customize Application" permission can remove the Submit & Add Attachment button from case
edit pages in the Customer Portal. Removing this button prevents portal users from submitting cases with attachments.
To remove the Submit & Add Attachment button:
1. Verify that the enhanced page layout editor is enabled for your organization:
a. Click Setup ➤ Customize ➤ User Interface.
b. Make sure that the Enable Enhanced Page Layout Editor checkbox is selected.
If the checkbox is not selected, select it and click Save.
For more information about the enhanced page layout editor, see "Customizing Page Layouts" in the Salesforce
online help.
2.
3.
4.
5.
6.
7.

Click Setup ➤ Customize ➤ Cases ➤ Page Layouts.
Click Edit next to a page layout from which you want to remove the Submit & Add Attachment button.
Click Layout Properties at the top of the enhanced page layout editor.
Deselect Show Submit & Add Attachment Button.
Click OK.
Click Save.

Self-Service Portal Enhancements
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Now, solutions print correctly when users click Printable View on solutions in the Self-Service portal.
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List Views for Sales and Account Teams
Available in: Enterprise, Unlimited, and Developer Editions

List Views for Account Teams
Account list views have been enhanced with a new filter for account team membership. When creating or editing an
account list view, select the My Account Teams radio button to restrict the records displayed to the accounts on which
you are an account team member.
List Views for Sales Teams
Opportunity list views have been enhanced with a new filter for sales team membership. When creating or editing an
opportunity list view, select the My Sales Teams radio button to restrict the records displayed to the opportunities
on which you are a sales team member.
Personal Edition Enhancements
Opportunities in Personal Edition
Personal Edition organizations created after Summer '09 do not include access to opportunities; however, existing
organizations still have access to opportunities.
Search Enhancements
Available in: All Editions

Search Result Ordering
There is a change to the order of results returned by search in certain circumstances, as well as which records are returned.
Previously, when relevancy scores for results were the same, records with the oldest creation date were returned first.
With Summer '09, the date a record was last indexed for search is used, so that the most-recently indexed records are
returned first. This change affects searches over large volumes of records of the same object type on a query that matches
thousands of results. Users may observe that the order of some results may change. In addition, records that were more
recently added or modified are more likely to appear in search results.
Search Optimized for Japanese, Chinese, and Korean
A new organization preference has been added for searching content that is in Japanese, Chinese, and Korean. By enabling
the feature, the sidebar search will return optimized results for those language. Do not check this option if you expect
content and searches to be mostly in other languages.
This can be managed under Setup ➤ Customize ➤ Search.
Use Recently Viewed User Records for User Lookups
If this feature is enabled, the list of records returned from a user auto-complete lookup and a user blank lookup is taken
from the user's recently viewed user records.
This can be managed under Setup ➤ Customize ➤ Search.

38

Salesforce Applications

Additional Salesforce Application Enhancements

Solution Search Enhancements
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Solution Search Results Display Accurate Numbers of Matching Solutions
Now, numbers displayed in parentheses and brackets in solution search results accurately indicate the number of solutions
that match a term for which you searched. For example, if you search for "Truck" and Truck (35) displays, then your
organization has 35 solutions with the term "Truck."
To search for solutions:
1. Click the Solutions tab.
2. Enter keywords related to a possible solution in the search box at the top of the page.
3. Click Find Solution.
Solution Search Results on Cases Display Fields Specified in the Solutions Search Results Layout
In Summer '09, solution search results on cases display the fields specified in the search results layout for solutions.
To choose which fields display in search results for solutions:
1.
2.
3.
4.

Click Setup ➤ Customize ➤ Solutions ➤ Search Layouts.
Click Edit next to Search Results.
Choose the fields to display on solution search results.
Click Save.

To search for solutions on cases:
1. On a case detail page, enter keywords related to a possible solution in the search box of the Solutions related list.
2. Click Find Solution.

Salesforce CRM Ideas Enhancements
Available in: Enterprise, Developer, and Unlimited Editions

The Ideas base theme is now available in the Summer '09 release. The base theme allows you to overwrite the standard Ideas
user interface with a new look and feel that is modeled after the Salesforce.com IdeaExchange. The Ideas base theme uses
Visualforce pages and controllers to provide functionality similar to the Salesforce CRM Ideas standard product. To start
using the base theme, contact salesforce.com and request to be part of the base theme limited availability program.
CTI (Computer-Telephony Integration) Support for Firefox
Available in: Professional, Enterprise, Unlimited, and Developer Editions

Now, version 1.53 of the Salesforce CRM Call Center CTI adapter is available for use with the Firefox 3.5.+ Web browser.
The CTI adapter will only work for Firefox when vendors update their distributions to use the latest CTI Toolkit. For more
information about the CTI adapter, see CTI Toolkit Developer's Guide. To download a CTI adapter from salesforce.com,
visit the Force.com AppExchange.
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Salesforce Analytics Enhancements
Summer '09 includes many new features that improve the capabilities of Salesforce analytics:
•
•
•
•
•
•
•
•
•

Chart Analytics 2.0
New Setup Navigation for Report and Dashboard Settings
Packageable Analytic Snapshots
New Default Record Type for Analytic Snapshots
Improved Filtering on Translated Multi-Select Picklists in Reports
New Character and Compiled-Formula Limits for Custom Summary Formulas
New Color Palette for Charts Available for Color-Blind Users
Updated Button Name for Unscheduling Dashboard Refreshes
Updated Online Help Topic on Chart and Component Types

About Salesforce Analytics Enhancements
Chart Analytics 2.0
Available in: All Editions

User Permissions Needed
To modify report and dashboard settings:

"Customize Application"

With Summer '09, Salesforce has upgraded its charting engine.
The new engine offers the following enhancements:
•
•
•
•
•
•
•
•
•
•
•
•

New chart colors
New chart types: donut and funnel
New chart styling for shading, highlights, title, legend, and axes
New data label options to show values, total, and percentages
New label truncation behavior (truncates the right side rather than the middle)
New option to show the legend on the chart for pie, donut, and funnel charts
New maximum title and text font size: to minimize text overflow, 18 point is the largest size allowed
Better decimal-place precision for numeric and currency values displayed on charts
Better handling when there is no data or other errors are encountered
Better image quality online and when using JPEG images in scheduled dashboards for Lotus Notes users
Better placement of pie chart labels to avoid overlap
Better handling of large data sets
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New color palette support for color-blind users
Better support for multiple languages and non-Latin characters

Every new organization automatically gets the new charting engine. Administrators for all existing organizations must opt in
manually by enabling the new charting engine. Once you enable the new engine, you cannot switch back to the old one.
Note: When you enable the new charting engine, all existing settings for charts on reports and dashboards are
automatically migrated, with no user action required. For example, existing formatting options and color choices are
preserved.
For existing organizations, upgrade to the new charting engine as follows:
1. Click Setup ➤ Customize ➤ Reports & Dashboards ➤ User Interface Settings.
2. Click Enable.
3. Confirm your choice by clicking Yes, Enable New Charting Engine.
Here is a comparison between the same charts from the old engine versus the new engine.

Figure 1: Charts Using the Old Engine

Figure 2: Charts Using the New Engine
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New Setup Navigation for Report and Dashboard Settings
Available in: All Editions

User Permissions Needed
To modify report and dashboard settings:

"Customize Application"

With Summer '09, there are changes to the Setup navigation for report and dashboard options. To access these settings, click
Setup ➤ Customize ➤ Reports & Dashboards, then select one of the following links:
•
•
•

Customize report and dashboard user interface settings—Control features of the report and dashboard user interface,
such as floating report headers, the auto-complete Dashboard Finder, and charting options.
Customize report and dashboard email settings—Control the way email notifications are sent, including image handling
in dashboard emails for Lotus Notes users and sending reports and dashboard refresh notifications to portal users.
Customize report folders—Click this link to go to the last open report folder. From there, you can edit folder properties,
such as name, access, and sharing.

These settings used to be located under Setup ➤ Customize ➤ User Interface.

Packageable Analytic Snapshots
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To create, save, and schedule an analytic snapshot:

"Manage Analytic Snapshots"

To run an analytic snapshot as a running user and add the
results to a custom object:

"Run Reports"
AND
"Create" on the target object

To create packages:

"Create AppExchange Packages"

With Summer '09, analytic snapshots are packageable as managed or unmanaged packages, and a new metadata component,
AnalyticSnapshot is available. You use packages to bundle an app along with any related components so that you can
upload them to Force.com AppExchange together. For information on packaging, see "Packageable Components" in the
Salesforce online help. For information on the new metadata component, see Force.com Development as a Service.
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New Default Record Type for Analytic Snapshots
Available in: Professional, Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To create, save, and schedule an analytic snapshot:

"Manage Analytic Snapshots"

To run an analytic snapshot as a running user and add the
results to a custom object, the running user must have:

"Run Reports"
AND
"Create" on the target object

With Summer '09, when defining an analytic snapshot, the custom object you choose receives the source report's results as
records when the analytic snapshot runs. If a record used for an analytic snapshot has no record type associated with it, the
record type of the running user is associated with the analytic snapshot by default.
An analytic snapshot enables users to run a tabular or summary report and save the report results to fields on a custom object.
With analytic snapshots, users with the appropriate permissions can map fields from a source report to the fields on a target
object, and schedule when to run the report to load the custom object's fields with the report's data. For more information,
see "What is an Analytic Snapshot?" in the Salesforce online help.

Improved Filtering on Translated Multi-Select Picklists in Reports
Available in: All Editions

User Permissions Needed
To create, edit, save, and delete reports:

"Create and Customize Reports"

With Summer '09, Salesforce has improved report filtering for multi-select picklists that have translated values. If the value
named in the filter is in both the base language and the user's language, the user's language is considered first when determining
which picklist value it corresponds to. For more information, see "Entering Filter Criteria" in the Salesforce online help.
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New Character and Compiled-Formula Limits for Custom Summary
Formulas
Available in: All Editions

User Permissions Needed
To create, edit, save, and delete reports:

"Create and Customize Reports"

With Summer '09, the maximum number of characters allowed a custom summary formula has been increased from 500 to
3900 characters, the same as other formulas.
In addition to the character limit on the formula field for custom summary formulas, there is also a limit on the size of the
compiled formula. Depending on your formula, even if you meet the character limit, your formula may exceed the compiled
limit and be rejected. For more information, see "Building Custom Summary Formulas" in the Salesforce online help.

New Color Palette for Charts Available for Color-Blind Users
Available in: All Editions

With Summer '09, a new Color-Blind Palette on Charts option is available. This option sets an alternate color palette
for charts that optimizes them for use by color-blind users. For dashboard emails, the alternate palette is not used. This option
is only available if the new charting engine has been enabled for your organization.
To enable this option:
1. Click Setup ➤ My Personal Information ➤ Personal Information.
2. Click Edit.
3. Select the Color-Blind Palette on Charts option.
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Updated Button Name for Unscheduling Dashboard Refreshes
Available in: Enterprise and Unlimited Editions

User Permissions Needed
To schedule and email a dashboard refresh:

“Schedule Dashboards”

To delete the schedule to refresh a dashboard:

"Modify All Data"

With Summer '09, the button on the Schedule Dashboard Refresh page to remove a scheduled dashboard refresh has been
renamed Unschedule Dashboard. The button used to be named Delete.
To delete a scheduled dashboard refresh:
1. Select the dashboard that has a scheduled refresh you want to delete from the View Dashboard drop-down list on the
Dashboards tab.
2. Click Refresh and choose Schedule Refresh... from the drop-down button
3. Click Unschedule Dashboard.
The scheduled refresh is permanently deleted and not sent to the Recycle Bin. Deleting the scheduled refresh does not
affect the dashboard itself.
For more informaton, see "Scheduling a Dashboard Refresh" in the Salesforce online help.

Updated Online Help Topic on Chart and Component Types
Available in: All Editions

With Summer '09, the Salesforce online help has been updated with the following new information on chart types:
Chart Type

Image

Description

Horizontal Bar

Use this type when you have a summary report with a single grouping, or you only want
to display one grouping. For example, to see the amount in each sales stage in a report, set
amount as the X-axis and stage as the Y-axis. The chart displays one bar for each stage,
with the length proportional to the total opportunity amount. The advantage of the
horizontal bar charts is that the chart can be extended vertically to show numerous
groupings, though the width is fixed.

Horizontal Bar:
Grouped

Use this type when you have multiple groupings, and you want to compare values within
a secondary grouping, but not the totals. For example, to compare the amount of deals
closed each month by lead source in a report, set amount as the X-axis, source as the
Y-axis, and closing month as the Groupings value. The chart displays a set of bars for
each source, one bar for each month. The monthly differences within a particular source
are easy to compare. You can also compare a given month across sources, but comparing
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Image

Description
the total number of leads for each source may be difficult. Use a stacked chart to compare
totals.

Horizontal Bar:
Stacked

Use this type when you have multiple groupings and are interested in the proportions
between values in each grouping, as well as each grouping's total. For example, to compare
the status of leads by campaign in a report, and also to compare the totals for each status,
set record count as the X-axis, status as the Y-axis, and campaign as the Groupings
value. The chart displays a single bar for each status, broken down by campaign, with each
campaign shown in a different color. The proportion of each campaign in each status is
easy to compare, as are the totals for each status, but comparing a single campaign’s
contribution to different statuses, or to the total, may be difficult.

Horizontal Bar:
Stacked to 100%

Use this type when you have multiple groupings and are only interested in the proportions
between values in each grouping, rather than the actual values. Since all bars are the same
length, actual values are not visible or relevant. For example, to see each owner's
opportunities proportioned by stage in a report, set opportunities as the X-axis, stage as
the Y-axis, and owner as the Groupings value. The chart displays one bar for each
owner, broken down by stage, with each segment representing the proportion of
opportunities in that stage against the total opportunities for that owner.

Vertical Column

Use this type when you have a summary report with a single grouping, or you only want
to display one grouping. For example, to see the number of leads by lead source in a report,
set record count as the Y-axis and source as the X-axis. The chart displays one column
for each source, with the height proportional to the total number of leads. The width of
column charts is constrained by dashboard column size and report chart size. Horizontal
bar charts may be better for large numbers of groupings. Column charts are good when
showing values by date, since dates traditionally run along the X-axis.

Vertical Column:
Grouped

Use this type when you have multiple groupings, and you want to compare values within
a secondary grouping, but not the totals. For example, to compare the number of
opportunities created each month by campaign source in a report, set record count as the
Y-axis, created month as the X-axis, and source as the Groupings value. The chart
displays a set of bars for each month, one bar for each campaign source. The differences
between sources within a particular month are easy to compare. You can also compare a
particular source across months, but comparing the total number of opportunities for each
month may be difficult. Use a stacked chart to compare totals.

Vertical Column:
Stacked

Use this type when you have multiple groupings and are interested in the proportions
between values in each grouping, as well as each grouping's total. For example, to compare
the number of opportunities created each month by campaign source in a report, and also
to compare the totals for each month, set record count as the Y-axis, created month as
the X-axis, and source as the Groupings value. The chart displays a single bar for each
month, broken down by source, with each source shown in a different color. The proportion
of each source in each month is easy to compare, as are the monthly totals, but comparing
a single source’s contribution to different months, or to the total, may be difficult.

Vertical Column:
Stacked to 100%

Use this type when you have multiple groupings and are only interested in the proportions
between values in each grouping, rather than the actual values. Since all columns are the
same height, actual values are not visible or relevant. For example, to see each month's
opportunities proportioned by campaign source in a report, set record count as the Y-axis,
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Image

Description
created month as the X-axis, and source as the Groupings value. The chart displays
one column for each month, broken down by source, with each segment representing the
proportion of opportunities generated from that source against the total opportunities for
that month.

Line

Use this type when you have one important grouping representing an ordered set of data
and one value to show. For example, to see the numbers of leads created each month in a
report, set record count as the Y-axis and created month for the X-axis. The chart
displays a line connecting the record count totals for each month. Line charts are especially
useful for showing data over time.
Salesforce does not plot missing (null) values. If a missing value occurs in the middle of a
data set, Salesforce displays a gap in the line.

Line: Grouped

Use this type when you have multiple groupings—each with one important secondary
grouping representing an ordered set of data—and one value to show. For example, to see
monthly leads by lead source in a report, set record count as the Y-axis, created month
as the X-axis, and source as the Groupings value. The chart displays a line for each
source, connecting that source's record count totals for each month. Each line spans the
earliest to the latest month containing data. Comparing the total numbers for each month
may be difficult.
Salesforce does not plot missing (null) values. If a missing value occurs in the middle of a
data set, Salesforce displays a gap in the line.

Line: Cumulative

Use this type when you have one important grouping representing an ordered set of data
and one value to show, summed over time. For example, to see the total amount of closed
opportunities by day in the current month in a report, set amount as the Y-axis and
closing day as the X-axis. The chart displays one line, with the line’s height representing
the cumulative amount of closed opportunities up to and including that day. You cannot
see the amount for any single day—only the cumulative amount.
If the data set contains a missing (null) value, Salesforce continues the line using the
previous value in the data set.

Line: Grouped
Cumulative

Use this type when you have multiple groupings—each with one important secondary
grouping representing an ordered set of data—and one value to show, summed over time.
For example, to see the total amount of closed opportunities by day for each of the last
three months in a report, set amount as the Y-axis, closing day as the X-axis, and
closing month as the Groupings value. The chart displays a line for each month, with
the line’s height representing the cumulative amount of closed opportunities up to and
including that day. You cannot see the amount for any single day—only the cumulative
amount.
If the data set contains a missing (null) value, Salesforce continues the line using the
previous value in the data set.

Pie

Use this type when you have multiple groupings and want to show the proportion of a
single value for each grouping against the total. For example, to see the breakdown of your
case queue by case status in a report, set record count for Values and status for Wedges.
The chart displays a circle made up of wedges, each wedge representing the cases in a case
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Image

Description
status. Wedge size is proportional to the numbers of cases. Pie charts are not ideal for
comparing values that are close together or numerous small values.
Select Show Labels, Show Values, or Show Wedge % to include that information on
the chart. (Only available with the new charting engine.)

Donut

Use this type when you have multiple groupings and want to show not only the proportion
of a single value for each grouping against the total, but also the total amount itself. For
example, to see the breakdown of your case queue by case status in a report, as well as the
total number of cases, set record count for Values and status for Wedges. The chart
displays a donut made up of wedges, each wedge representing a case status. Wedge size is
proportional to the numbers of cases. The total number of cases for all statuses is shown
in the middle.
Select Show Labels, Show Values, Show Wedge %, or Show Total to include that
information on the chart. (Only available with the new charting engine.)

Funnel

Use this type when you have multiple groupings in an ordered set and want to show the
proportions among them. For example, to see the amount of opportunities in each stage
in a report, set amount for Values and stage for Segments. Since the Opportunity:
Stage field is an ordered picklist, the stages are sorted in the same order as the picklist,
with each segment representing the amount for that stage. Funnel charts are useful for
showing the flow of opportunities through the stages; a substantially larger segment may
indicate a bottle-neck at that stage.
Select Show Labels, Show Values, or Show Segment % to include that information
on the chart. (Only available with the new charting engine.)

The online help topic also includes the following new information on component types:
Component Type

Image

Description

Table

For dashboards only. Use a table when you have one important grouping and want to show
a numeric value for each value in the grouping. For example, to see the top 20 opportunities
by amount, set Maximum Values Displayed to 20, and set Sort By to Row Value
Descending. In the report used for this dashboard, you can display a horizontal bar chart
with opportunity name as the Y-axis and opportunity amount as the X-axis to visually
display opportunity amounts.

Metric

For dashboards only. Use a metric when you have one key value to display. For example,
if you have a report showing the total amount for all opportunities in the Closed, Commit,
and Base Case stages in the current month, you can name that value and use it as a
revenue target for the month displayed on the dashboard.

Gauge

For dashboards only. Use a gauge when you have a single value that you want to show
within a range of custom values. For example, to create a dashboard that measures where
your current closed opportunity amounts fall within a range of values, set the Minimum
Value, Breakpoint #1 Value, Breakpoint #2 Value, and Maximum Value for
the gauge. The ranges that you set can indicate poor, acceptable, and good performance.
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Image

Description
Set appropriate colors for each of these ranges to visually indicate progress. To create a
gauge with only two ranges, leave Breakpoint #2 Value blank.
Select Show Percentage or Show Total to display those values on the gauge. Values
exceeding the maximum are shown as greater than 100%. (Only available with the new
charting engine.)

Visualforce Page

N/A

Use a Visualforce page when you want to create a custom component or show information
not available in another component type. For example, a Visualforce page could display
data from an external system or show Salesforce data in a custom way. Visualforce pages
that were previously created by a developer or administrator can display in a dashboard if
they meet certain requirements. Visualforce pages that do not meet the requirements do
not appear in the Visualforce Page drop-down list.

Custom s-control

N/A

Custom s-controls can contain any type of content that you can display or run in a browser,
for example, a Java applet, an ActiveX control, an Excel file, or a custom HTML Web
form.
Attention: S-controls have been superseded by Visualforce pages. After January
2010 salesforce.com will remove the ability to create and distribute new s-controls.
Existing s-controls will remain unaffected.

Use the information in this help topic to aid your decisions when choosing which type of chart to use for reports and dashboards.
For more information, see "Chart and Component Types" in the Salesforce online help.

Process Visualizer (BETA)
Available in: Enterprise, Unlimited, and Developer Editions

Summer ’09 introduces the Process Visualizer, which allows you to see graphical versions of your defined approval processes.
The feature is in Beta testing and available for preview in this release. A known limitation is that the Process Visualizer does
not currently support a printable view. Your feedback and suggestions for improvements are welcome! To submit comments
during the Beta, click the IdeaExchange link in the top banner of the Process Visualizer or go directly to the Salesforce
IdeaExchange website. During the beta period, the Process Visualizer is not officially supported by salesforce.com Customer
Support.
The Process Visualizer displays view-only diagrams that use flowchart notation to represent elements found in approval
processes, such as an entry criteria, numbered steps, and approval or rejection paths by designated persons. The shapes in each
diagram are based on the Business Process Modeling Notation (BPMN) standard. When you hover over or click an element
on the approval process diagram, the Process Visualizer provides details about that element in an informational sidebar.
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About the Process Visualizer
Using the Process Visualizer
Available in: Enterprise, Unlimited, and Developer Editions

User Permission Needed
To view approval steps:

"View Setup and Configuration"

Note: The Process Visualizer is available for Beta testing. A known limitation is that the Process Visualizer does not
currently support a printable view. Your feedback and suggestions for improvements are welcome! To submit comments
during the Beta, click the IdeaExchange link in the top banner of the Process Visualizer or go directly to the Salesforce
IdeaExchange website. During the beta period, the Process Visualizer is not officially supported by salesforce.com
Customer Support.
You can use the Process Visualizer to:
•
•
•
•

Display a flowchart of each saved approval process
Document the decisions you reached when the approval process was designed
Improve communication about the approval process and gain buy-in from step owners
Help you visualize and understand:
-

The steps necessary for a record to be approved
The designated approvers for each step
The criteria used to trigger the approval process
The specific actions to take when a record is approved, rejected, recalled, or first submitted for approval

Launching the Process Visualizer
Available in: Enterprise, Unlimited, and Developer Editions

User Permission Needed
To view approval steps:

"View Setup and Configuration"

Note: The Process Visualizer is available for Beta testing. A known limitation is that the Process Visualizer does not
currently support a printable view. Your feedback and suggestions for improvements are welcome! To submit comments
during the Beta, click the IdeaExchange link in the top banner of the Process Visualizer or go directly to the Salesforce

50

Force.com Platform

Process Visualizer (BETA)

IdeaExchange website. During the beta period, the Process Visualizer is not officially supported by salesforce.com
Customer Support.
Before you can use the Process Visualizer, you must:
•
•

Enable or download the Adobe Flash Player plugin, version 9.0.115 or later, in your browser
Have at least one approval process defined in your organization

After completing those prerequisites:
1. Click Setup ➤ Create ➤ Workflow & Approvals ➤ Approval Processes.
2. From the list of approval processes, click the name of the one you want to view.
3. On the detail page for the approval process, click View Diagram BETA.
Each approval process diagram is for viewing purposes only. You cannot update an approval process from the Process Visualizer.
After saving your changes to the approval process, click View Diagram BETA to view the updates or, if the Process Visualizer
window is still open, click Refresh.

Understanding the Process Visualizer User Interface
Available in: Enterprise, Unlimited, and Developer Editions

User Permission Needed
To view approval steps:

"View Setup and Configuration"

This topic contains the following sections:
•
•
•
•

About the Process Visualizer UI
Displaying Hover Details for an Approval Process Diagram
Refreshing an Approval Process Diagram
Displaying Approval Process Properties
Note: The Process Visualizer is available for Beta testing. A known limitation is that the Process Visualizer does not
currently support a printable view. Your feedback and suggestions for improvements are welcome! To submit comments
during the Beta, click the IdeaExchange link in the top banner of the Process Visualizer or go directly to the Salesforce
IdeaExchange website. During the beta period, the Process Visualizer is not officially supported by salesforce.com
Customer Support.

About the Process Visualizer UI
The user interface for the Process Visualizer is organized into several functional areas.
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Figure 3: Process Visualizer User Interface
The highlighted numbers in the previous illustration correspond to the following descriptions:
1. The main area presents the approval process diagram, helping you visualize the overall flow, rules, actions, and dependencies.
The diagram's orientation is top-to-bottom, left-to-right. The entry criteria for the approval process is shown at the top
of the diagram. The processing of a record moves down the flowchart until the final approval or rejection is achieved. Each
flowchart component uses a shape, an icon, or both to represent the type of processing that may happen.
2. The diagram's legend summarizes the icons that may be displayed. When you first use the Process Visualizer, the legend
is collapsed. To display the legend, click the right arrow. When you subsequently open other diagrams, the Process Visualizer
remembers your last setting (expanded or collapsed) for the legend.
3. To the left of the diagram, the Process Visualizer displays an informational sidebar. The top pane in the sidebar presents
the Approval Process Properties. Its display is collapsed by default. The Approval Process Properties pane lists information
such as the name of the approval and whether it has been activated. Expand the pane by clicking the right-arrow icon.
4. The bottom pane of the left sidebar contains the hover details, which lists information about the currently selected component
on the diagram. You can hover over or click a component to view its details, such as the entry criteria used to trigger the
approval process, or the name of the person who must take action on the request.
5. Buttons on the bottom of the page allow you to refresh the diagram or close the Process Visualizer.
Displaying Hover Details for an Approval Process Diagram
When you hover over or click a flowchart component on an approval process diagram, the Process Visualizer displays information
about it in the hover details pane. The information remains there until you hover over or click a different component on the
diagram.
The following table lists the type of information you can see in the hover details.
Component Type

Hover Detail Message Formats

Approval steps

Approval required from:
• User: user-name
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Hover Detail Message Formats
•

Role: role-name

Or if defined for the step, one of the following values:
•
•
•

Submitter can choose approver
Automatically assigned to Manager field
Unanimous approval required from: approver-1,
approver-n...

•
•
•

Approval based on first response from: approver-1,
approver-n...
Related User: object-name Owner

The approver's delegate may also approve this request

Field updates

•
•
•

Email alerts

Send (email-template) email to recipient-1,

Update field-name with lookup value: lookup-value
Update field-name with value: value
Update field-name with formula: formula

recipient-n...

Tasks

Assign task to assignee with due date: date

Outbound messages

Send the fields field-1, field-n,... to endpoint:
endpoint-url

Refreshing an Approval Process Diagram
Each approval process diagram is for viewing purposes only. You cannot update an approval process from the Process Visualizer.
After saving your changes to the approval process, click View Diagram BETA to view the updates or, if the Process Visualizer
window is still open, click Refresh.
Displaying Approval Process Properties
In the left sidebar of the Process Visualizer, the Approval Process Properties pane lists the information shown in the following
table. If the Approval Process Properties pane's display is collapsed, click the right arrow to expand it. When you subsequently
open other diagrams, the Process Visualizer remembers your last setting (expanded or collapsed) for the properties pane.
Property

Description

Process Name

A user-defined name of the approval process.

Active?

Indicates whether the approval process is active.

Record Editability

Shows the defined value for this property. For example:
Administrator or current approver.

Next Automated Approver Determined By

Shows the value for this property. For example: Manager of
Owner

Approval Assignment Email Template

The name of the template used for email alerts. For example:
Leads: New assignment notification (SAMPLE)
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Property

Description

Initial Submitters

Shows the defined value for this property. For example: Record
Owner

Allow Submitters to Recall Approval Requests?

Shows the defined value, Yes or No, for this property.

Created By

The name of the person who created the approval process.

Modified By

The name of the last person to modify the approval process.

Description

The description of the approval process.

Understanding the Process Visualizer Notation
Available in: Enterprise, Unlimited, and Developer Editions

User Permission Needed
To view approval steps:

"View Setup and Configuration"

Note: The Process Visualizer is available for Beta testing. A known limitation is that the Process Visualizer does not
currently support a printable view. Your feedback and suggestions for improvements are welcome! To submit comments
during the Beta, click the IdeaExchange link in the top banner of the Process Visualizer or go directly to the Salesforce
IdeaExchange website. During the beta period, the Process Visualizer is not officially supported by salesforce.com
Customer Support.
The Process Visualizer uses the following notation to graphically represent each approval process. The shapes are based on
the Business Process Modeling Notation (BPMN) standard. In the Process Visualizer, a shape's color changes from gray to
blue when you hover over or click it.
Icon and Shape Examples

Description
Near the top of the diagram, a Start circle indicates the beginning of the approval process.
If defined, an Entry Criteria precedes the Start circle and is represented by a diamond
labeled Entry Criteria. When you hover over or click an Entry Criteria, the Process
Visualizer displays the entry criteria in the left sidebar's hover details pane. For example, an
approval process for a Lead object is triggered when Lead.AnnualRevenue >= 10000.
The arrow below the Start circle leads to the next criteria in the approval process. If a recall
action was defined for the entry criteria, a line to the right connects to the Final Recall
Actions circle.
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Description
The rectangle labeled Initial Submission represents any actions you defined in initial
submission. At a minimum, this element shows the record lock set automatically by Salesforce
to prevent updates by other users. Later during the approval process, after the record is
approved, rejected, or recalled, the record is unlocked.

A diamond with Yes or No branches represents the numbered step's criteria or formula that
is evaluated before proceeding. Hover over or click the diamond to see the criteria or formula
in the left sidebar's hover details. For example, the criteria could be used to determine whether
the Lead.Rating = Hot. If true, the approval process continues to the next step on the
Yes branch. If false, the approval process continues to the next step on the No branch.

An approval step is represented by a rectangle containing a human icon,
path includes a small diamond. The Rejected path uses a backslash.

. The Approved

A rectangle without a human icon or a plus sign represents a single action. The action types
and icons are:
•
Send an email alert:
•
Start a task:
•
Perform a field update:
•
Send an outbound message:
In this example, a task has been assigned. When you hover over or click the rectangle, look
for more information in the left sidebar's hover details.
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Description
A rectangle with a plus sign (+) represents multiple actions. The actions shown inside a
dashed-line rectangle are performed simultaneously, as a unit. To expand the display and
view the individual actions, click the plus sign. In the expanded display, the Process Visualizer
displays the individual actions, one per rectangle.

When you hover over or click a shape on the diagram, and it is part of a step, all the elements
that comprise the step use a glowing background color. This visual clue helps you locate all
the decisions and actions that comprise each step, and how the processing may branch based
on the record's values.

In the approval process definition, if the option was enabled to perform only the rejection
actions for this step and send the approval request back to the most recent approver. (go back
one step), the diagram displays a Go Back circle. When you hover over or click the Go Back
circle, the hover details pane displays a message. For example:
On rejection send the request back to any one of the following
steps, depending on the most recent approver: - list-of-steps. If
no approvers are found, the request goes to Final Rejection.

The identified steps depend on where in the approval process the Go Back was defined. The
possible steps are highlighted when you hover over the Go Back circle. In the diagram, the
Process Visualizer displays the Go Back circle only for a step where its preceding step is
defined as a skip.
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Description
The final approval actions rectangle leads to a circle labeled End Approval, as shown here.
The final rejection actions rectangle leads to a circle labeled End Rejection. If a recall
action was defined, the final recall actions rectangle shows that the record is now unlocked,
and the arrow leads to a circle labeled Recalled.

Force.com Sites Enhancements—Generally Available
Available in: Developer, Enterprise, and Unlimited Editions

With Summer '09, Force.com Sites is generally available! This release includes many new features that improve the capabilities
of Force.com Sites:
•
•
•
•
•

Force.com Sites Usage Reporting
Automatic Caching Support for Force.com Sites Pages
Validation of Custom Web Address for Force.com Sites
Updated Limits and Billing for Force.com Sites
New 24-Hour Usage History Related List
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About Force.com Sites Enhancements
Force.com Sites Usage Reporting
User Permissions Needed
To install packages:

"Download AppExchange Packages"

To run reports:

"Run Reports"
AND
"Read" on the records included in reports

To create, edit, save, and delete reports:

"Run Reports" and "Read" on the records included in the
reports
AND
"Create and Customize Reports"

To create, edit, and delete dashboards:

"Run Reports"
AND
"Manage Dashboards"

With Summer '09, you can install a managed package that contains analytics tools to use on Force.com Sites. Use the packaged
reports and dashboard to monitor individual site usage or usage across all the sites in your organization. These analytics can
indicate which sites are consuming the most resources and help you avoid exceeding monthly page view limits, daily bandwidth
limits, and daily service request time limits, which can shut down your site.
To find the Force.com Sites Usage Reporting managed package, go to AppExchange and search on “sites reporting,” or go
to http://sites.force.com/appexchange/listingDetail?listingId=a0N30000001SUEwEAO.
The Force.com Sites Usage Reporting managed package contains the following reports to help you perform analytics on usage
for the sites in your organization. You can find these reports in the Site Usage Reports folder under All Reports in the Reports
tab. You can also select Site Usage Reports in the Folder drop-down list, then click Go.
Note: Site usage data is aggregated at midnight, GMT, so the current day's page view counts may not be accurately
reflected in reports, depending on your time zone. Cache server page views may take a day or more to be reflected in
reports.
Report

Description

Current Period Page Views

Shows the total page views for the current period (calendar month), measured against
page views allowed. Page views are broken down by site and by day. The current period
limit applies to all sites within the organization.

Daily Total Bandwidth Usage

Shows the total bandwidth usage over the last 30 days, broken down by site, by day, and
by origin and cache servers.
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Report

Description

Daily Total Page Views

Shows the total page views over the last 30 days, broken down site, by day, and by origin
and cache servers.

Site Daily Origin Bandwidth
Usage

Shows the total origin bandwidth usage over the last 30 days, broken down by site and
by day.

Site Daily Request Time Usage

Shows the total origin service request time over the last 30 days, broken down by site and
by day.

Top Bandwidth Consuming Sites Shows the sites that consumed the most bandwidth during the current period.
Top Resource Consuming Sites

Shows the sites that consumed the most service request time during the current period.

Top Sites by Page Views

Shows the sites that generated the most page views during the current period.

You can also create custom reports on Force.com Sites:
1. From the Reports tab, click Create New Custom Report.
2. For the report type, select Administrative Reports, then Site Usage Reports. You must enable Force.com Sites for your
organization and install the Force.com Sites Usage Reporting managed package to see the Site Usage Reports custom
report type.
3. Click Next and follow the instructions for creating a custom report. Fields related to your sites, such as Site Name, Site
Status, Daily Bandwidth Limit, and Daily Request Time Limit can all be used in your custom report.
Note: When you create your own custom reports using the Site Usage Reports custom report type, be aware that the
Origin Bandwidth column is measured in bytes, and the Request Time column is measured in milliseconds.
Make sure you consider the difference in units when comparing these columns to the Daily Bandwidth Limit
and Daily Request Time Limit columns, which are measured in megabytes and minutes, respectively.
For the out-of-the-box reports included with the managed package, bandwidth is measured in megabytes and request
time is measured in minutes.
The Force.com Sites Usage Reporting managed package contains the Site Usage Dashboard to help you monitor the sites in
your organization at a glance. The dashboard contains a component for each of the reports provided in the managed package.
To access the dashboard, from the Dashboards tab:
•
•

Use the View Dashboard field
Or, click Go to Dashboard List and select Site Usage Dashboard from the Folder drop-down list.

To modify the dashboard, click Edit and follow the instructions for editing dashboards. You can also create your own custom
dashboard using any custom reports you may have created. Consider adding the Site Usage Dashboard as the dashboard
snapshot on your home page.
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Figure 4: The Site Usage Dashboard

Automatic Caching Support for Force.com Sites Pages
User Permissions Needed
To create and edit Force.com sites:

"Customize Application"

With Summer '09, new caching behavior is available for Force.com Sites.
To help you avoid reaching bandwidth or service request time limits, Force.com Sites provides caching options that allow you
to leverage the resources of our Content Delivery Network (CDN) partner. Force.com Sites allows you to set the cache duration
for each of your site pages and optimize content delivery to your end users.
Control the caching behavior for your site by setting the Boolean cache attribute and integer expires attribute on each
Visualforce page. By default, pages that do not have the cache attribute set are cached for ten minutes (600 seconds).
For example, a page whose cache is set to expire in 15 minutes looks like this:
<apex:page cache="true" expires="900">

Note: The CDN is only available for active production organizations. It is not available for sandbox or Developer
Edition organizations.
To protect the integrity of sensitive information, SSL sessions and pages requested after authentication are not cached
via the CDN.
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Attachments to public pages accessed through Force.com Sites are automatically cached for 10 minutes via the CDN.
For more information, see "Caching Force.com Sites Pages" in the Salesforce online help.

Validation of Custom Web Address for Force.com Sites
User Permissions Needed
To create and edit Force.com sites:

"Customize Application"

With Summer '09, salesforce.com now validates the top-level domain name that you enter in the Custom Web Address
field. The custom Web address acts as an alias to your Force.com address. To enable a custom Web address, create a CNAME
record to your Force.com domain with that registrar. If you have not registered this address, you encounter an error. Custom
Web addresses are not available in sandbox or Developer Edition organizations. If the domain is not registered to you, validation
fails and you receive an error message.
For more information, see "Creating and Editing Force.com Sites" in the Salesforce online help.

Updated Limits and Billing for Force.com Sites
User Permissions Needed
To create and edit Force.com sites:

"Customize Application"

With Summer '09, the following updates have been made to sites limits and the behavior when monthly page view limits are
exceeded:
New Force.com Sites Limits
The following table lists the site limits for each edition:
Edition

Maximum
Number of Sites

Bandwidth Limit (per
rolling 24-hour period)

Service Request Time (per Maximum Page
rolling 24-hour period)
Views

Developer Edition 1

500 MB

10 minutes

N/A

Free Edition

10,000 MB

360 minutes

250,000

1 GB for sandbox

30 minutes for sandbox

500,000

40 GB for production

60 hours for production

1 GB for sandbox

30 minutes for sandbox

40 GB for production

60 hours for production

1

Enterprise Edition 25

Unilimited
Edition

25

1,000,000

Billing and Monthly Page Views Enforcement
The following describes how salesforce.com enforces limits on monthly page views for Force.com Sites:
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Billing is based on the number of monthly page views purchased for your organization. This page view limit is
cumulative for all sites in your organization.
If, in a given calendar month, your organization reaches 110% of its page view limit, salesforce.com sends the site
and billing administrators email notification.
If your organization exceeds 110% of its page view limit for four consecutive calendar months, your sites are disabled
until the next calendar month begins or you purchase more page views. Also, salesforce.com sends email notification
to the site and billing administrators, as well as the related account executive.
If, in a given calendar month, your organization reaches 300% of its page view limit, your sites are disabled until the
next calendar month begins or you purchase more page views. Also, salesforce.com sends email notification to the
site and billing administrators, as well as the related account executive.

The following new help content is also available:
Limits and Billing Terminology
This section describes how salesforce.com enforces limits on monthly page views for Force.com Sites:
•
•
•
•
•
•
•

"Page Views" are calculated as the number of pages served from both the site's origin server and the cache server.
"Bandwidth" is calculated as the number of megabytes served and received from both the site's origin server and the
cache server.
"Service request time" is calculated as the total server time in minutes required to generate pages for the site.
"Rolling 24-hour period" refers to the 24 hours immediately preceding the current time.
"Origin server" refers to the Web server that hosts your site.
"Cache server" refers to the CDN server that serves your cached site pages.
"Current period" refers to the current calendar month for which you are entitled a certain number of page views for
your organization.

What Counts as a Page View?
This section describes how page views are counted for Force.com Sites.
A page view is a request from a non-authenticated site user to load a page associated with one of the sites within your
Force.com domain or custom domain. Requests from authenticated portal users are not counted as page views.
Requests that Count as Page Views
Requests for the following are counted as page views:
Requests for...

Example URL

Your Force.com domain

http://mycompany.force.com

Your custom Web address

http://mycompany.com

Any page associated with your site

http://mycompany.force.com/mypage

Ajax requests

n/a

Requests that Do Not Count as Page Views
Requests for the following are not counted as page views:
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Requests for...

Example URL

Salesforce images

http://mycompany.force.com/img/force_logo_w09.gif

Your static resources

http://mycompany.force.com/resource/1233771498000/background

Robots.txt

http://mycompany.force.com/robots.txt

Favorite icon

http://mycompany.force.com/favicon.ico

Attachments and Documents

n/a

Error Pages, such as Bandwidth Exceeded http://mycompany.force.com/BandwidthExceeded
and In Maintenance

Note: Usage of the Bandwidth Limit Exceeded Page, the Maintenance Page, and the designated Inactive
Home page are not counted against page view and bandwidth limits. You can use static resources to brand
these pages, but the following limitations apply:
•
•
•
•

Static resources must be 50 KB or smaller in size.
Static resources must be stylesheets (CSS), image files, or javascript files.
You cannot use Apex controllers for these pages.
You cannot perform SOQL or DML operations from these pages.

For more information, see "Force.com Sites Limits and Billing" in the Salesforce online help.

New 24-Hour Usage History Related List
User Permissions Needed
To create and edit Force.com sites:

"Customize Application"

With Summer '09, a new related list named 24-Hour Usage History is available on the Site Detail page. Monitor the bandwidth
and request time usage for each of your sites by viewing the usage data tracked on this related list. By closely monitoring your
sites, you can avoid exceeding your limits.
The 24-Hour Usage History related list tracks and displays the following usage metrics for your site:
•
•

Origin Bandwidth—Bandwidth is calculated as the number of megabytes served and received from the site's origin server.
The Daily Limit applies to a rolling 24-hour period.
Request Time—"Service request time" is calculated as the total server time in minutes required to generate pages for the
site. The Daily Limit applies to a rolling 24-hour period.

"Origin server" refers to the Web server that hosts your site. "Rolling 24-hour period" refers to the 24 hours immediately
preceding the current time.
For each metric, the related list displays Current Usage, Daily Limit, and the Percent Used.
To view the 24-hour usage history for your site:
1. Click Setup ➤ Develop ➤ Sites.
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2. Click the name of the site you want to view.
3. View the 24-Hour Usage History related list.
For more information, see "Force.com Sites Limits and Billing" in the Salesforce online help.

Enhanced Declarative Logic For Picklists
Available in: All Editions

Summer '09 has improved how Salesforce handles picklists in formulas:
New INCLUDES Function Added
The INCLUDES function determines if any value selected in a multi-select picklist field equals a text literal you specify.
The syntax is:
INCLUDES(multiselect_picklist_field, text_literal)

Replace multiselect_picklist_field with the merge field name for the multi-select picklist; and replace
text_literal with the multi-select picklist value you want to match in quotes.
For example, the following formula in a workflow rule configures Salesforce to trigger the associated workflow actions
if the Competitor multi-select picklist field on a lost opportunity is Acme:
ISPICKVAL(Stage, “Closed Lost”) && INCLUDES(Competitor__c, “Acme”)

Note the following:
•
•

The text_literal expression must be of type text and enclosed in quotes. It cannot be a merge field or the result
of a function.
Salesforce returns an error if any of the following occurs:
-

•
•

You do not provide a text_literal expression.
You provide a text_literal expression that does not equal a value defined for the multi-select picklist.
You provide an empty text_literal expression, such as "" or " ".

Use ISNULL to determine if a multi-select picklist field is empty.
Use the PRIORVALUE function inside the INCLUDES function to check if the previous value of a multi-select
picklist field included a specific value. For example:
INCLUDES(
PRIORVALUE(multiselect_picklist_field),text_literal
)

Multi-Select Picklist Support in ISCHANGED, ISNULL, and PRIORVALUE Functions
In previous releases, formulas could not reference multi-select picklists. Now, in addition to the new INCLUDES
function, the ISCHANGED, ISNULL, and PRIORVALUE functions can reference multi-select picklists in formulas.
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For example, the following validation rule prevents you from saving an opportunity if the a deal is lost and no competitor
is selected:
ISPICKVAL(Stage, “Closed Lost”) && ISNULL(Competitor__c)

Picklist Support in TEXT Functions for Formula Fields and Workflow Field Updates
In Spring '09, Salesforce added the ability to use a picklist value in a formula field without ISPICKVAL by adding
picklist support in TEXT functions for validation rules. In Summer '09, you can now use the TEXT function to reference
picklist values in formula fields and workflow field updates as well. This allows you to manipulate a picklist value as a
text value, expanding the types of business logic and calculations you can perform, such as:
•

Use text functions and operators, such as CONTAINS, BEGINS, LEFT, MID, UPPER, and LOWER, on picklist
values. For example:
IF(CONTAINS(TEXT(Status)), "Closed"), "Closed", "Open")

•

Use numeric functions on numeric picklist values. For example, the following formula multiplies the first five numbers
of the Quantity picklist by the Unit numeric field:
VALUE(LEFT(TEXT(Quantity), 5)) * Unit

•

Directly compare two picklists. For example, the following formula compares the values of the bug_status picklist
with values of the case_status picklist:
IF(TEXT(bug_status) = TEXT(case_status), “Match”, “Out of Sync”)

•

Display picklist values from parent records. For example, the following formula field on opportunities shows the
industry of the associated account:
TEXT(Account.Industry)

•

Concatenate picklist values to present them in a sentence or as a group. For example, the following formula field on
opportunities shows the industry and subindustry of the associated account:
TEXT(Account.Industry) & " - " & TEXT(Account.SubIndustry__c)

Note the following:
•
•
•

Salesforce still supports ISPICKVAL. Existing formulas are not affected.
Picklist fields are only supported in TEXT functions used in validation rule formulas, formula fields, and field updates.
In other formulas, use ISPICKVAL or CASE when referencing a picklist field.
The TEXT function always returns picklist values in your organization's master language, not the language of the
current user.
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Force.com Apex Code Enhancements
Available in: Unlimited, Developer, and Enterprise Editions

Force.com Apex code includes the following enhancements in Summer '09. Refer to the Force.com Apex Code Developer's
Guide for complete information about Apex.
The following enhancement is only available as limited release:
Batch Apex -- Limited Release
Have you ever wanted to build a process to validate all of your account addresses? Or perhaps build a background process,
iterating through millions of records, creating object relationships based on complex logic? What if you could implement
these processes natively on the Force.com platform? With Summer '09, batch Apex releases the power of asynchronous
batch processing. Customers, developers, and ISVs can now build and deploy complex business processes, operating over
entire data sets, leveraging the power and flexibility of the Force.com asynchronous platform.
Note: Batch Apex is currently available through a limited release program. For information on enabling batch
Apex for your organization, contact salesforce.com.

The following enhancements are generally available:
New Method for Messaging.SingleEmailMessage
When sending an outbound messaging using Messaging.SingleEmailMessage, you have the option of setting an
object ID for an organization-wide address through setOrgWideEmailAddressId. For more information, see Using
Apex with an Organization-Wide Address on page 30.
New Method for UserInfo
UserInfo has a new method associated with the License Management App:
isCurrentUserLicensed

Returns true if the context user has a license to the managed package denoted by namespace. Otherwise, returns
false.
New Methods for DescribeFieldResult, DescribeSObjectResult, and ChildRelationship
The following methods have been added to the DescribeFieldResult, DescribeSObjectResult, and ChildRelationship
objects. The same methods were added to all three objects. These methods are reserved for future use:
•
•

isDeprecated
isDeprecatedAndHidden

New Bitwise Exclusive OR Operator Supported and Boolean Supported
The bitwise exclusive OR operator (^=) is now supported. It functions similarly to the Java bitwise exclusive OR operator:
it exclusively ORs each bit in x with the corresponding bit in y so that the result bit is set to 1 if exactly one of the bits
is set to 1 and the other bit is set to 0
In addition, the following bitwise operators now support Boolean values:
•

&
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|
^

Additional sObjects That Do Not Support DML Operations
The following sObjects do not support DML operations:
•
•
•

ApexComponent
ApexPage
StaticResource

Heap Size Doubled
The heap size for all Apex contexts has been doubled.
Number of Rows Returned by Query Locator Increased
The number of records returned in the Database.QueryLocator object has been increased to 50 million.
Callout SOAP Response Limit Increased
The size of a SOAP request from, or response to, an Apex callout is limited to 1 MB.
Apex Triggers
You can now view a list of all triggers defined for your organization. Click Setup ➤ Develop ➤ Apex Triggers. You
cannot create a new trigger from this page; however, you can view all triggers. Clicking the name of a trigger takes you
to the detail page for that trigger.
New Graphical Representation of Code Coverage
The results returned from both Run Test and Run All Tests in the Salesforce user interface have been improved. You
can collapse and expand every section. In addition, there is a new code coverage section. This section lists all the classes
and triggers in your organization and the percentage of lines of code in each class and trigger that are covered by tests.
If you click on the coverage percent number, a page displays, highlighting all the lines of code for that class or trigger
that are covered by tests in blue, as well as highlighting all the lines of code that are not covered by tests in red. It also
lists how many times a particular line in the class or trigger was executed by the test.
Transferring Record Ownership in System Mode
Apex now always runs in system mode when transferring ownership of opportunity, contact, account, or contract records.
Previously, you could not transfer owners on these types of records using a before trigger unless the user initiating the
operation had "Transfer Record" permission or had transfer access to the record by virtue of sharing.
Additional Reserved Words
The following words are now considered reserved, that is, you cannot use them as the name of a class, method, or variable.
•
•

array
int
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Create QueryLocator Objects Dynamically
You can now create a QueryLocator object by passing a string to the qetQueryLocator method. This enables you
to dynamically create batch Apex jobs or a Visualforce StandardSetController. In the following example, AccountSetCon
uses a string, one that could be set dynamically, to create the StandardSetController:
public AccountSetCon() {
String query = 'SELECT name,createddate FROM account ORDER BY createddate DESC';
Database.QueryLocator ql = Database.getQueryLocator(query);
ssc = new ApexPages.StandardSetController(ql);
ssc.setPageSize(5);
}

Apex Language Reference title changed to Force.com Apex Code Developer's Guide
The official name of the Apex Language Reference has been changed to the Force.com Apex Code Developer's Guide.

Force.com Web Services API Enhancements
Available in: Enterprise, Unlimited, and Developer Editions

The Force.com Web Services API version 16.0 contains new features and bug fixes that improve the capabilities of applications
that leverage the Force.com platform. Considerable effort has been made to ensure backwards capability for applications that
have been written against previous versions of the API, starting with API 2.5.
Note: The older XML-RPC API remain unchanged with this release.

The new API provides a number of powerful enhancements that further improve any integration already in place between
Salesforce and your other systems.
After Summer '09, the 15.0 version of the WSDL file is no longer available. Instead, all requests for a WSDL return a 16.0
version. Please remember to save WSDL files with your project, as the enterprise WSDL is custom to your organization.
Salesforce maintains backwards compatibility with previous versions of our API in accordance with our stated support policy.
We recommend that developers migrate to the latest version of the API as often as is feasible in order to receive the benefit
of new enhancements from release to release. Developers with integrations on API versions prior to version 2.5 should plan
to migrate to the most recent API in preparation for the eventual end of support for the older API versions.
Generally Available Enhancements
The Force.com Web Services API has been improved for Summer '09:
New Objects
The following new objects have been added in API version 16.0:
•
•
•

The DivisionLocalization object represents a translated value for a label in a division.
The OrgWideEmailAddress object represents an email alias for user profiles.
The RecordTypeLocalization object represents a translated value for a label in a record type.
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Changed Objects
The following objects have been changed in API version 16.0:
•

The following Account object fields now support the update() call:
-

•
•
•
•

IsCustomerPortal
IsPartner

API versions 16.0 and later require that users have "Transfer Record" permission in order to update the OwnerID
field (transfer account ownership) on the Account object.
The ApexPage and ApexComponent objects have added the ApiVersion field to support versioning of Visualforce
pages and components.
The ActivityHistory object no longer supports the IsOnlineMeeting field becauseSalesforce no longer supports
the WebEx integration feature.
In API versions 16.0 and later, the create() call on the CampaignMember object only creates a new record; in
earlier API versions, the create() call on the CampaignMember object creates and updates records.
In API versions 16.0 and later, the upsert() call, which creates and updates records, is supported on the
CampaignMember object; in earlier API versions, the upsert() call is not supported.
To update an existing campaign member record in API version 16.0 and later, use the update() call and specify
the ID of the CampaignMember record to update.

•
•
•

The Event object field IsVisibleInSelfService now supports the update() call.
The Task object field IsVisibleInSelfService now supports the update() call.
The Task object has the following new fields to support recurring tasks:
-

•
•

The User object includes the new IsPortalEnabled field, which indicates whether a user has access to a Partner
Portal or Customer Portal. The IsPortalEnabled field supports the disabling portal user feature.
The Case and CaseComment objects have the following new fields to support Salesforce to Salesforce:
-

•

IsRecurrence
RecurrenceActivityID
RecurrenceDayOfMonth
RecurrenceDayOfWeek
RecurrenceDayOfWeekMask
RecurrenceEndDateOnly
RecurrenceInstance
RecurrenceInterval
RecurrenceMonthOfYear
RecurrenceStartDateOnly
RecurrenceTimeZoneSidKey
RecurrenceType

ConnectionReceivedID
ConnectionSentID

If you are uploading leads using API version 15.0 or earlier, and one of the leads in the batch has a partner user as
the owner, the Partner Account field on all leads in the batch is set to that partner user’s account regardless of
whether the partner user is the owner. In version 16.0, the Partner Account field is set to the appropriate account
for the partner user that owns the lead. If the owner of the lead is not a partner user, this field remains blank.
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Changed Calls
•
•

You can specify the value for a new, optional argument, OrgWideEmailAddressId, when using sendEmail()
to send a single email.
In query() or wherever else SOQL is used, such as in an Apex script, the SOQL SELECT filter LIKE now supports
escaping wildcard characters % and _.

New SOAP Headers
PackageVersionHeader specifies the package version referenced by an API client for each installed managed package.
A managed package can have several versions with different content and behavior. This header allows you to specify the
version used for each package referenced by your API client. If a package version is not specified for a package, the API
client uses the version of the package that is selected in the Version Settings section in Setup ➤ Develop ➤ API.
New Package Version Settings on WSDL Download Page
There is a new Package Version Settings section in the WSDL download page at Setup ➤ Develop ➤ API that is
visible in organizations with installed managed packages. Package subscribers can specify the default package versions
for enterprise API and partner API calls. Default package versions for API calls provide fallback settings if package
versions are not provided by an API call. Many API clients do not include package version information, so the default
settings maintain existing behavior for these clients.
Updated Process for Downloading the Enterprise WSDL
If you are downloading an enterprise WSDL and you have managed packages installed in your organization, you need
to take an extra step to select the version of each installed package to include in the generated WSDL.
API Migration Issues
The following technical notes are available to assist you in migrating from earlier versions:
•
•
•
•
•
•

Release 4.0: http://www.salesforce.com/developer/tech-notes.jsp?tn=TN-10
Release 5.0: http://www.salesforce.com/developer/tech-notes.jsp?tn=TN-13
Release 6.0: http://www.salesforce.com/developer/tech-notes.jsp?tn=TN-15
Release 7.0: http://www.salesforce.com/developer/tech-notes.jsp?tn=TN-17
Release 8.0: http://www.salesforce.com/developer/tech-notes.jsp?tn=TN-19
Release 9.0:
http://wiki.apexdevnet.com/index.php/What%27s_New_in_Apex_Web_Services_API_Spring_%2707

•

Release 10.0:
http://wiki.apexdevnet.com/index.php/What%27s_New_in_Apex_Web_Services_API_Summer_%2707

•

Release 11.0:
http://wiki.apexdevnet.com/index.php/What%27s_New_in_Force.com_Web_Services_API_Winter_%2708

•

Release 12.0:
http://wiki.apexdevnet.com/index.php?title=What%27s_New_in_Force.com_Web_Services_API_Spring_%2708

•

Release 13.0:
http://wiki.apexdevnet.com/index.php/What%27s_New_in_Force.com_Web_Services_API_Summer_%2708

•
•

Release 14.0: Force.com Web Services API Developer's Guide Version 14.0
Release 15.0: Force.com Web Services API Developer's Guide Version 15.0

Documentation for these earlier versions is also available. See
http://wiki.apexdevnet.com/index.php/Earlier_API_Doc on Developer Force for links to HTML and PDF

versions.
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Visualforce Enhancements
Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, and Developer Editions
Custom controllers and standard controller extensions are not supported in Contact Manager, Group, or Professional
Editions.

Summer '09 introduces several new features that enhance the capabilities of previous versions of Visualforce. For detailed
information on these new features, see the Visualforce Developer's Guide.
The following enhancements are now available:
Versioned Visualforce Pages and Components
Starting with the Summer '09 release, Visualforce pages and components are versioned. When a page or component has
a version number, the functionality of older Visualforce elements does not change as new implementations are introduced.
To aid backwards-compatibility, each Visualforce page is saved with version settings for the specified version of the API
as well as the specific version of Visualforce. If the Visualforce page references installed managed packages, the version
settings for each managed package referenced by the Visualforce component is saved too. This ensures that as Visualforce,
the API, and the components in managed packages evolve in subsequent versions, a page is still bound to versions with
specific, known behavior.
A new Version Settings tab has been added to all existing Visualforce pages and components in order to manage
between versions.
To set the Salesforce API and Visualforce version for a Visualforce page:
1. Edit a Visualforce page and click Version Settings.
Note: You can only access the version settings for a page if you edit a page by clicking Setup ➤ Develop
➤ Pages. You cannot access them if you edit a page using Developer Mode.
2. Select the Version of the Salesforce API. This is also the version of Visualforce used with the page.
3. Click Save.
In addition, the following changes affect Visualforce page versions 16.0 and above:
Deprecated Attributes
The following attributes cannot be used in Visualforce page versions 16.0 and above:
•

Within <apex:page>:
-

•

recordSetName

Within <apex:column>:
-

footercolspan
footerdir
footerlang
footeronclick
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-

footerondblclick
footeronkeydown
footeronkeypress
footeronkeyup
footeronmousedown
footeronmousemove
footeronmouseout
footeronmouseover
footeronmouseup
footerstyle
footertitle
headercolspan
headerdir
headercolspan
headerdir
headerlang
headeronclick
headerondblclick
headeronkeydown
headeronkeypress
headeronkeyup
headeronmousedown
headeronmousemove
headeronmouseout
headeronmouseover
headeronmouseup
headerstyle
headertitle

Changes to Access Levels
Beginning with version 16.0, if you have a managed global Apex class used as a Visualforce controller, it is also
required that the access level be set to global for the following methods and properties for subscribers to use
them:
•
•
•

Constructors for custom controllers
Getter and setter methods, including those for input and output components
Get and set attributes on properties

Visualforce Pages Match Salesforce API Version
As of version 16.0, Visualforce pages that are created through the Force.com Web Services API default to the
Salesforce API version in which they are created. A new field, ApiVersion, has been added to the ApexPage and
ApexComponent API objects. You may set the value of ApiVersion yourself.
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Existing ApexPage and ApexComponent objects that were created through earlier versions of the API will remain
at their current version. If you want to change their version number, you may do so through the API, or through
the new Version Settings tab.
Full Page Refresh when Calling <apex:actionSupport>
If there is no rerender attribute set for <apex:actionSupport>, the component performs a full page refresh
when invoked.
The tabStyle Attribute Requires a Namespace
Previously, if the tabStyle attribute on an <apex:page> component did not have a namespace, Visualforce
checked any installed packages for the referenced tab style. In version 16.0 and above, if you are referencing a tab
in a managed package, the namespace must precede the tab name.
Expressions Are Not Allowed in ID Attributes
You may no longer use expressions, such as {!account.name}, within the ID string for components.
All Visualforce Pages Include <html> and <head> Elements
All Visualforce pages of version 16.0 or higher will include <html> and <head> elements. Prior versions may not
include those elements if none of the components on the page required them.
Object-Level Help Using Visualforce Pages
Object-level help overrides the Help for this Page links for any custom object with your own custom help content. This
content can now be contained in a Visualforce page.
Dashboard Components Using Visualforce Pages
Dashboard components provide information on data within your organization. You can now create Visualforce pages
that run as dashboard components.
You can use the action attribute on a <apex:page> component to redirect from a Visualforce page to a static resource.
This functionality allows you to add rich, custom help to your Visualforce pages. For example, to redirect a user to a
PDF:
1. Upload the PDF as a static resource named customhelp.
2. Create the following page:
<apex:page sidebar="false" showHeader="false" standardStylesheets="false"
action="{!URLFOR($Resource.customhelp)}">
</apex:page>

Notice that the static resource reference is wrapped in a URLFOR function. Without that, the page does not redirect
properly.
This redirect is not limited to PDF files. You can also redirect a page to the content of any static resource. For example,
you can create a static resource that includes an entire help system composed of many HTML files mixed with JavaScript,
images, and other multimedia files. As long as there is a single entry point, the redirect works. For example:
1. Create a zip file that includes your help content.
2. Upload the zip file as a static resource named customhelpsystem.
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3. Create the following page:
<apex:page sidebar="false" showHeader="false" standardStylesheets="false"
action="{!URLFOR($Resource.customhelpsystem, 'index.htm')}">
</apex:page>

When a user visits the page, the index.htm file in the static resource displays.
Use Dynamic SOQL in a List Controller Constructor
You can now create a QueryLocator object by passing a string to the qetQueryLocator method. This enables you
to dynamically create batch Apex jobs or a Visualforce StandardSetController. In the following example, AccountSetCon
uses a string, one that could be set dynamically, to create the StandardSetController:
public AccountSetCon() {
String query = 'SELECT name,createddate FROM account ORDER BY createddate DESC';
Database.QueryLocator ql = Database.getQueryLocator(query);
ssc = new ApexPages.StandardSetController(ql);
ssc.setPageSize(5);
}

New ID Generation for <apex:actionStatus> and <apex:panelBarItem>
The document object model ID generation for the <apex:actionStatus> component has changed. Now, the ID is
prepended by the IDs of any container tags.
Note: The ID generation change only affects Visualforce pages that use version 16 or higher.

In addition, <apex:panelBarItem> has been added to the naming hierarchy. Any child tags of
<apex:panelBarItem> are prepended with the ID of <apex:panelBarItem> and any parent container tags.
New Standard Controller for CampaignMember
CampaignMember is now supported in Visualforce through a standard controller.
New Attribute on <apex:actionSupport>
The <apex:actionSupport> component has the following new attribute:
disabled

A Boolean value that allows you to disable the component. When set to true, the action is not invoked when the
event is fired.
New Attributes on <apex:panelBarItem>
The apex:panelBarItem component has the following new attributes which can be used to trigger JavaScript:
onenter

The JavaScript invoked when the panelBarItem is not selected and the user clicks on the component to select
it.
onleave

The JavaScript invoked when the panelBarItem is selected and the user selects a different panelBarItem.
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Updated Functionality of <apex:relatedList>
When defining a related list, the list attribute of <apex:relatedList> does not need to reference a related list that
exists on an object's page layout. It can take the value of any valid related list for the object.
Updated Attributes on <apex:page>
The following existing attributes of the <apex:page> component behave differently for Visualforce pages used in
Force.com Sites:
cache

A Boolean value that specifies whether the browser should cache this page. If set to true, the browser caches the
page. If not specified, this value defaults to false. For Force.com Sites pages, if this attribute is not specified, this
value defaults to true.
expires

The expiration period for the cache attribute in seconds. If the cache attribute is set to tre, but this attribute is
not specified, this value defaults to zero. For Force.com Sites pages, if cache is not set to false, this value defaults
to 600 seconds.
For details on caching site pages, see "Caching Force.com Sites Pages" in the Salesforce online help.
New Attributes on <apex:toolbar>
The <apex:toolbar> component has the following new attributes which can be used to trigger JavaScript:
onclick
The JavaScript invoked if the onclick event occurs—that is, if the user clicks the toolbar.
ondblclick
The JavaScript invoked if the ondblclick event occurs—that is, if the user clicks the toolbar twice.
onitemclick
The JavaScript invoked if the user clicks on a component in the toolbar that is not in a toolbarGroup component.
onitemdblclick
The JavaScript invoked if the user clicks twice on a component in the toolbar that is not in a toolbarGroup
component.
onitemkeydown
The JavaScript invoked if the user presses a keyboard key on a component in the toolbar that is not in a toolbarGroup
component.
onitemkeypress
The JavaScript invoked if the user presses or holds down a keyboard key on an item in the toolbar that is not in a
toolbarGroup component.
onitemkeyup
The JavaScript invoked if the user releases a keyboard key on an item in the toolbar that is not in a toolbarGroup
component.
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onitemmousedown
The JavaScript invoked if the user clicks a mouse button on an item in the toolbar that is not in a toolbarGroup
component.
onitemmousemove
The JavaScript invoked if the user moves the mouse pointer while focused on an item in the toolbar that is not in
a toolbarGroup component.
onitemmouseout
The JavaScript invoked if the user moves the mouse pointer away from the an item in the toolbar that is not in a
toolbarGroup component.
onitemmouseover
The JavaScript invoked if the user moves the mouse pointer over an item in the toolbar that is not in a toolbarGroup
component.
onitemmouseup
The JavaScript invoked if the user releases a mouse button on an item in the toolbar that is not in a toolbarGroup
component.
onkeydown
The JavaScript invoked if the onkeydown event occurs—that is, if the user presses a keyboard key.
onkeypress
The JavaScript invoked if the onkeypress event occurs—that is, if the user presses or holds down a keyboard key.
onkeyup
The JavaScript invoked if the onkeyup event occurs—that is, if the user releases a keyboard key.
onmousedown
The JavaScript invoked if the onmousedown event occurs—that is, if the user clicks a mouse button.
onmousemove
The JavaScript invoked if the onmousemove event occurs—that is, if the user moves the mouse pointer.
onmouseout
The JavaScript invoked if the onmouseout event occurs—that is, if the user moves the mouse pointer away from
the toolbar.
onmouseover
he JavaScript invoked if the onmouseover event occurs—that is, if the user moves the mouse pointer over the
toolbar.
onmouseup
The JavaScript invoked if the onmouseup event occurs—that is, if the user releases the mouse button.
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Visualforce Samples Updated
The samples within the Component Reference Guide, which is available on every Visualforce page and in the Visualforce
Developer's Guide, have been updated. Examples for each component have been updated to provide more information,
more functionality, and more complexity.
Visualforce Developer's Guide Chapter Additions and Rearrangement
The following chapters have been renamed in the Visualforce Developer's Guide:
•
•
•
•
•

Getting A Quick Start with Visualforce (previously called A Quick Start Tutorial)
Styling Visualforce Pages (previously called Page Styles)
Adding Functionality using Controllers (previously called Visualforce Controllers)
Using Static Resources (previously called Static Resources)
Creating and Using Custom Components (previously called Custom Components)

The following chapters have been reordered as standalone chapters in the Visualforce Developer's Guide:
•
•
•

Introducing Visualforce and Getting A Quick Start with Visualforce (both previously under Introduction)
Standard Component Reference (previously under Appendices)
Advanced Examples (previously under Custom Controllers and Controller Extensions)

The following chapters are new in the Visualforce Developer's Guide:
•
•
•
•

Integrating Email with Visualforce: Provides information on sending email with Visualforce and on using Visualforce
email templates
Templating with Visualforce: Describes different strategies for creating content that can be reused in multiple
Visualforce pages
Best Practices: Lists strategies to maximize the functionality of your Visualforce pages and components
Glossary: Defines key terms used throughout the Visualforce Developer's Guide

Force.com Development as a Service
Force.com Development as a Service (DaaS) provides the tools and technologies used by professional developers who build
applications for the Force.com platform, as well as those who migrate application changes between development organizations
and production. The DaaS feature area includes support for creating, retrieving, and deploying changes to your organization's
metadata.
New Metadata Types
The following metadata types are new in Metadata API version 16.0:
Metadata Type

Description

AnalyticSnapshot

This component represents an analytic snapshot. To use this metadata component, you
must have the "Manage Analytic Snapshots" permission.

77

Force.com Platform

Force.com Development as a Service

Updated Metadata
Beginning with version 16.0, Metadata API supports picklist definitions for custom or standard fields in a standard object,
such as an account, as well as continued support for custom picklist fields in custom objects. The following metadata fields
have been added or changed in Metadata API version 16.0:
Metadata Type

Field

Change

Description

ApexClass

packageVersions

New

The list of installed managed package
versions that are referenced by this Apex
class. A package version is a set of
components uploaded in a package. It is
denoted by a version number,
majorNumber.minorNumber, such as
2.1.

ApexComponent

apiVersion

New

The API version for this Visualforce
component. Every component has an API
version specified at creation.

ApexComponent

packageVersions

New

The list of installed managed package
versions that are referenced by this
Visualforce component.

ApexPage

packageVersions

New

The list of installed managed package
versions that are referenced by this
Visualforce page.

ApexTrigger

packageVersions

New

The list of installed managed package
versions that are referenced by this Apex
trigger.

AsyncResult

checkOnly

New

Indicates whether this deployment is
being used to check the validity of the
deployed files without making any
changes in the organization (true) or not
(false). A check-only deployment does
not deploy any components or change the
organization in any way.

AsyncResult

numberComponentErrors

New

The number of components that
generated errors during this deployment.

AsyncResult

numberComponentsDeployed

New

The number of components that have
been deployed so far for this deployment.

AsyncResult

numberComponentsTotal

New

The total number of components in the
deployment.

AsyncResult

numberTestErrors

New

The number of Apex tests that have
generated errors during this deployment.

AsyncResult

numberTestsCompleted

New

The number of Apex tests that have
completed so far for this deployment.

AsyncResult

numberTestsTotal

New

The total number of Apex tests in the
deployment.
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Metadata Type

Field

Change

Description

AsyncResult

stateDetail

New

Indicates which component is currently
being deployed or which Apex test class
is running.

AsyncResult

stateDetailLastModifiedDate

New

The data and time when the
stateDetail field was last modified.

CustomField

label

Updated

This field is no longer required. You can
now use this metadata type to work with
picklists in standard objects, such as
accounts. You cannot update the label for
a standard picklist field.

CustomObject

customHelpPage

New

The Visualforce page that contains the
help content if this custom object has
customized help content.

CustomObjectTranslation workflowTasks

New

A list of workflow task translations.

CustomSite

favoriteIcon

New

The name of the file to be used for the
icon that appears in the browser's address
field when visiting the site. Sets the
favorite icon for the entire site.

CustomSite

indexPage

Updated

This field is now required. Use this
metadata type to set the active home page
for your Force.com site.

Dashboard

componentType (in

Updated

Two new valid values have been added to
this metadata type: donut and funnel. Use
these values to set the chart type for the
dashboard.

DashboardComponent)

Dashboard

legendPosition (in

Updated

DashboardComponent)

The location of the legend with respect
to the chart. The valid values are:
•
•
•

Bottom
OnChart
Right

Dashboard

page (in DashboardComponent)

New

Visualforce page associated with the
component.

Dashboard

pageHeightInPixels (in

New

Display height of the Visualforce page in
pixels.

New

Indicates if percentages are displayed for
wedges and segments of pie, donut, and
funnel charts, as well as for gauges (true),
or not (false).

showTotal (in DashboardComponent) New

Indicates if the total is displayed for donut
charts and gauges (true), or not (false).

DashboardComponent)
Dashboard

showPercentage (in

DashboardComponent)

Dashboard
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Metadata Type

Field

Change

Description

Dashboard

showValues (in DashboardComponent) New

Indicates if the values of individual records
or groups are displayed for charts (true),
or not (false).

EmailTemplate

apiVersion

New

The API version if this is a Visualforce
email template. Every Visualforce email
template has an API version specified at
creation.

EmailTemplate

packageVersions

New

The list of package versions for any
managed packages containing components
that are referenced by this email template.
This field is only relevant for Visualforce
email templates.

Layout

showSubmitAndAttachButton

New

Only allowed on Case layout. If set, the
Submit & Add Attachment button
displays on case edit pages to portal users
in the Customer Portal.

PicklistValue

closed

New

Indicates whether this value is associated
with a closed status (true), or not
(false). This field is only relevant for
the standard Status field in cases and
tasks.

PicklistValue

converted

New

Indicates whether this value is associated
with a converted status (true), or not
(false). This field is only relevant for
the standard Lead Status field in leads.

PicklistValue

cssExposed

New

Indicates whether this value is available
in your Self-Service Portal (true), or not
(false). This field is only relevant for
the standard Case Reason field in cases.

PicklistValue

description

New

Description of a custom picklist value.
This field is only relevant for the standard
Stage field in opportunities. It is useful
to include a description for a customized
picklist value so that the historical reason
for creating it can be tracked.

PicklistValue

forecastCategory

New

Indicates whether this value is associated
with a forecast category (true), or not
(false). This field is only relevant for
the standard Stage field in opportunities.

PicklistValue

highPriority

New

Indicates whether this value is a high
priority item (true), or not (false).
This field is only relevant for the standard
Priority field in tasks.

PicklistValue

probability

New

Indicates whether this value is a
probability percentage (true), or not
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Field

Change

Description
(false). This field is only relevant for
the standard Stage field in opportunities.

PicklistValue

reviewed

New

Indicates whether this value is associated
with a reviewed status (true), or not
(false). This field is only relevant for
the standard Status field in solutions.

PicklistValue

won

New

Indicates whether this value is associated
with a closed or won status (true), or not
(false). This field is only relevant for
the standard Stage field in opportunities.

Report

showPercentage (in ReportChart)

New

Indicates if percentages are displayed for
wedges and segments of pie, donut, and
funnel charts, as well as for gauges (true),
or not (false).

Report

showTotal (in ReportChart)

New

Indicates if the total is displayed for donut
charts and gauges (true), or not (false).

Report

showValues (in ReportChart)

New

Indicates if the values of individual records
or groups are displayed for charts (true),
or not (false).

Report

chartType

Updated

Two new valid values have been added to
this metadata type: donut and funnel. Use
these values to set the chart type for the
report.

Workflow

description (in WorkflowAlert).

New

Required. A description of the email alert.
Available in API version 16.0 and later.

Workflow

name (in WorkflowFieldUpdate).

New

Required. A name for the component.
Available in version API 16.0 and later.

Workflow

name (in WorkflowOutboundMessage). New

Required. A name for the component.
Available in version API 16.0 and later.

Workflow

subject (in WorkflowTask).

Required. A subject for the workflow task.
It is used if an email notification is sent
when the task is assigned. Available in
API version 16.0 and later.

New

Monitoring Metadata Deployments
Available in: Enterprise, Unlimited, and Developer Editions

You can use the Metadata API to deploy XML file representations of components into an organization. A component is an
instance of a metadata type in the Metadata API. For example, MyCustomObject__c is an instance of a custom object.
The deploy call in the Metadata API is asynchronous and may take a while to complete. To track the status of deployments
that are in progress or completed in the last 24 hours for these tools or other clients that are deploying metadata, click Setup
➤ Deploy ➤ Monitor Deployments.
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Force.com Migration Tool Enhancements
Available in: Enterprise, Unlimited, and Developer Editions

You can use the Force.com Migration Tool to retrieve and deploy metadata using Apache Ant.
To download the Force.com Migration Tool, click Setup ➤ Develop ➤ Tools ➤ Force.com Migration Tool. For instructions
on how to use the tool, open the Readme.html file included with the tool. For more information, see the Force.com Migration
Tool Guide.
The Force.com Migration Tool has been improved for Summer '09. The build.xml file specifies a series of commands to
be executed by Ant. Within the build.xml file are named targets that process a series of commands when you run Ant with
a target name.
Updated Targets
The following new parameters have been added:
•

•

The retrieve and bulkRetrieve targets have a new unzip parameter. Optional. Defaults to true. If set to
true, the retrieved components are unzipped. If set to false, the retrieved components are saved as a zip file in
the retrieveTarget directory.
The deploy target has a new apiVersion parameter that represents the version of the Metadata API for the
deployment.

When you run a target, the Force.com Migration Tool outputs the request ID for each deploy or retrieve task included in the
target. You can use the request ID to check the status of a deploy or retrieve task. This is particularly useful if a client is running
for a long time and there is a network issue that breaks the connectivity between the Force.com Migration Tool on your
machine and Salesforce.
To check the status of a run target, use the following command:
ant -Dsf.asyncRequestId=requestID targetName

Use the requestID that was printed out when you ran the target. For example, if you run the deployZip target, you can
run the following command to check the status of the retrieval:
ant -Dsf.asyncRequestId=04sx00000002aGuAAI deployZip

Note: You should not use this command with targets that contain multiple retrieve or deploy tasks. You should not
use this command with the bulkRetrieve task also as this task batches retrievals in multiple requests.

Sharing Setup UI Enhancements
Available in: Professional, Enterprise, Unlimited, and Developer Editions

With Summer '09, the following features for managing large amounts of data have been added to many sharing pages:
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Filtered list views
To show a filtered list of items, select a predefined list from the View drop-down list, or click Create New View to
define your own custom view. To edit or delete any view you created, select it from the View drop-down list and click
Edit.
Links to sort items by first letter or other characters
At the top of a list, click a letter to show items that correspond to that letter, or click Other to show items whose names
begin with numbers or symbols. Click All to display all items that match the criteria of the current view.
Links to previous and next pages for multi-page lists
Click the Previous Page or Next Page link to go to the previous or next set of items in the current view.
Links to show fewer or more items for lists with more than ten items
At the bottom of a list, click the fewer or more link to decrease or increase the number of items per page.
Additionally, several related lists now include:
Link to show more items in lists with more than five items
Click Show [number] more to increase the number of items in the list.
Link to a separate list page in lists with more than five items
Click Go to list to display a secondary page of the entire related list.
The following table lists the pages and related lists that now include these features:
Page or Related List
Sharing Details page for individual records

Feature
Filtered list views
Links to sort items by first letter or other characters
Links to previous and next pages for multi-page lists
Links to show fewer or more items for lists with more than
ten items

All Sharing Users page for individual records

Filtered list views
Links to sort items by first letter or other characters
Links to previous and next pages for multi-page lists
Links to show fewer or more items for lists with more than
ten items

Role Sharing Groups page

Filtered list views

Role and Subordinates Sharing Groups page

Links to sort items by first letter or other characters

Role and Internal Subordinates Sharing Groups page

Links to previous and next pages for multi-page lists
Links to show fewer or more items for lists with more than
ten items
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Feature
Link to show more items in lists with more than five items
Link to a separate list page in lists with more than five items

Users in Role secondary list page

Filtered list views
Links to sort items by first letter or other characters
Links to previous and next pages for multi-page lists
Links to show fewer or more items for lists with more than
ten items

Territory Sharing Groups page

Filtered list views

Territory and Subordinates Sharing Groups page

Links to sort items by first letter or other characters
Links to previous and next pages for multi-page lists
Links to show fewer or more items for lists with more than
ten items

Individual territory page, Assigned Users related list

Link to show more items in lists with more than five items
Link to a separate list page in lists with more than five items

Assigned Users secondary list page

Filtered list views
Links to sort items by first letter or other characters
Links to previous and next pages for multi-page lists
Links to show fewer or more items for lists with more than
ten items

Individual territory page, Inherited Account Assignment Rules
Link to show more items in lists with more than five items
related list
Link to a separate list page in lists with more than five items
Inherited Account Assignment Rules secondary list page

Filtered list views
Links to sort items by first letter or other characters
Links to previous and next pages for multi-page lists
Links to show fewer or more items for lists with more than
ten items

Individual Territory page, Manually Assigned Accounts related
Link to show more items in lists with more than five items
list
Link to a separate list page in lists with more than five items
Manually Assigned Accounts secondary list page

Filtered list views
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Feature
Links to sort items by first letter or other characters
Links to previous and next pages for multi-page lists
Links to show fewer or more items for lists with more than
ten items

Public Groups list page

Filtered list views
Links to sort items by first letter or other characters
Links to previous and next pages for multi-page lists
Links to show fewer or more items for lists with more than
ten items

Individual group page, Group Members related list

Link to show more items in lists with more than five items
Link to a separate list page in lists with more than five items

Group Members secondary list page

Filtered list views
Links to sort items by first letter or other characters
Links to previous and next pages for multi-page lists
Links to show fewer or more items for lists with more than
ten items

Individual group page, All Users in Group related list

Link to show more items in lists with more than five items
Link to a separate list page in lists with more than five items

All Users in Group secondary list page

Filtered list views
Links to sort items by first letter or other characters
Links to previous and next pages for multi-page lists
Links to show fewer or more items for lists with more than
ten items

Queues list page

Filtered list views
Links to sort items by first letter or other characters
Links to previous and next pages for multi-page lists
Links to show fewer or more items for lists with more than
ten items

Individual queue page, Queue Members related list

Link to show more items in lists with more than five items
Link to a separate list page in lists with more than five items
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Queue Members secondary list page
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Feature
Filtered list views
Links to sort items by first letter or other characters
Links to previous and next pages for multi-page lists
Links to show fewer or more items for lists with more than
ten items

Individual queue page, All Users in Queue related list

Link to show more items in lists with more than five items
Link to a separate list page in lists with more than five items

All Users in Queue secondary list page

Filtered list views
Links to sort items by first letter or other characters
Links to previous and next pages for multi-page lists
Links to show fewer or more items for lists with more than
ten items

Application Distribution: Version Tracking Enhancements
Available in: Group, Professional, Enterprise, Unlimited, and Developer Editions

With Summer '09, you can include a Version Number, such as 2.1, when uploading your packages. The format is
majorNumber.minorNumber. The version number represents a release of a package and greatly reduces the administration
overhead required to track all your package uploads. Subscribers can also see the version number so they can include a specific
version number when communicating with you about a package. The existing Version Name field should be used as the
marketing name for a specific release of a package.
Implementation Tips
•
•
•
•
•

The major version number must be greater than or equal to 1.
The minor version number must be greater than or equal to 0.
All Managed - Beta uploads for a managed package have the same version number. After a Managed - Released upload,
you can upload another package version with a new version number.
For existing packages, the version number is automatically populated.
The version number for an upload cannot be less than the version number for any previous upload. For example, if the last
upload was for version 2.5, you cannot upload with version numbers 1.6 or 2.4.

Best Practices
•

Decide on a version numbering scheme before you start uploading packages. Typically, the major number portion of the
version number should be incremented when substantial changes are made to your application. The minor number should
be incremented when small fixes are released.
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Use the Version Name field on a package upload as the marketing name for a particular release of your application: for
example, June 2009.
Use the version number when you are tracking feature requests or bugs in your packages or when communicating with
subscribers. This eases the process of tracking changes to your packages.

About Application Distribution: Version Tracking Enhancements
Uploading Packages
To upload a package with a version number:
1. Enter a Version Name, such as June 2009. This field is required for managed and unmanaged packages. The version
name is the marketing name for a specific release of a package and allows you to create a more descriptive title for the
package.
2. Enter a Version Number for the upload, such as 1.0. The format is majorNumber.minorNumber.
The version number represents a release of a package. This field is required for managed and unmanaged packages. For a
managed package, the version number corresponds to a Managed - Released upload. All Managed - Beta uploads use the
same version number until you upload a Managed - Released package version with a new version number. For example,
the following is a sequence of version numbers for a series of uploads.
Upload
Sequence

Type

Version Notes
Number

First upload

Managed - Beta

1.0

The first Managed - Beta upload.

Second upload Managed - Released

1.0

A Managed - Released upload. Note that the version number
does not change.

Third upload

1.1

Note the change of minor release number for this Managed Released upload.

Fourth upload Managed - Beta

2.0

The first Managed - Beta upload for version number 2.0. Note
the major version number update.

Fifth upload

2.0

A Managed - Released upload. Note that the version number
does not change.

Managed - Released

Managed - Released

3. For managed packages, select a Release Type:
•

•

Choose Managed - Released to upload an upgradeable version. After upload, some attributes of Salesforce components
are locked. For a list of locked attributes, see "Component Attributes in Managed Packages" in the Salesforce online
help.
Choose Managed - Beta if you want to upload a version of your package to a small sampling of your audience for testing
purposes. You will still be able to change the components and upload additional beta versions. For information on beta
versions, see "Beta Versions of Managed Packages" in the Salesforce online help.
Note: Beta packages can only be installed in Developer Edition or sandbox organizations.
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4. Change the Description, if necessary.
5. Optionally, enter and confirm a password to share the package privately with anyone who has the password. Do not enter
a password to make the package available to anyone on AppExchange and share your package publicly.
6. Salesforce automatically selects the requirements it finds. In addition, select any other required components from the
Package Requirements and Object Requirements sections to notify installers of any requirements for this package.
7. Click Continue.
There are new icons related to managed packages:
•

(Managed - Beta)—The package or component was created in the current Salesforce organization and is managed, but
it is not released.

•

(Managed - Released)—The package or component was created in the current Salesforce organization and is managed.
It is also uploaded with the Managed - Released option selected, indicating that it can be published on AppExchange
and is publicly available.

•

(Managed - Installed)—The package or component was installed from another Salesforce organization but is managed.

Application Distribution: Versioning and Deprecation for
Apex
Available in: Enterprise, Unlimited, and Developer Editions

With Summer '09, developers who create managed packages for the AppExchange can now evolve Apex code included in
their packages while maintaining full backwards compatibility. Customers can install upgrades from the AppExchange without
worrying about breaking their existing integrations.
A package version is a set of components uploaded in a package. It is denoted by a version number,
majorNumber.minorNumber, such as 2.1.
After you upload another package version as Managed - Released, new subscribers that install the latest package version cannot
see the deprecated Apex identifiers, while the Apex code continues to function for existing subscribers and API integrations.
When developers in subscriber organizations install multiple versions of your package and write code that references components
in your package, they must select the package version that they are referencing using the Version Settings. The version
of each installed managed package can be viewed on the detail pages and set on the create and edit pages for the following
items:
•
•
•
•
•

Apex classes
Apex triggers
Visualforce pages
Visualforce components
Visualforce email templates

In addition, package developers who include Apex code in their packages can use the deprecated annotation to identify
methods, classes, exceptions, enums, interfaces, and variables that can no longer be referenced in subsequent releases of the
managed package in which they reside. This is useful when you are refactoring code in managed packages. The
that an Apex class has been deprecated.

icon indicates
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Subscribers with installed managed packages can specify the default package versions for enterprise API and partner API calls.
Default package versions for API calls provide fallback settings if package versions are not provided by an API call. Many API
clients do not include package version information, so the default settings maintain existing behavior for these clients.
For more information about default package version settings, see Configuring Default Package Versions for API Calls.
Implementation Tips
•

•
•
•
•

When an existing subscriber installs a new package version, there is still only one instance of each component in the package,
but the components can emulate older versions. For example, a subscriber may be using a managed package that contains
an Apex class. If the publisher decides to deprecate a method in the Apex class and release a new package version, the
subscriber still sees only one instance of the Apex class after installing the new version. However, this Apex class can still
emulate the previous version for any code that references the deprecated method in the older version.
If you save Apex code or Visualforce markup that references an installed managed package without specifying a version of
the managed package, the code or markup is associated with the latest installed version of the managed package by default.
Unmanaged packages cannot contain code that uses the deprecated keyword.
You cannot remove the deprecated annotation to undeprecate an Apex identifier after you have released a package
version where the identifier is deprecated.
The First Installed Version Number field on the package detail page in a subscriber organization shows the first
installed version of the package in the subscriber's organization. The subscriber can reference this version and any subsequent
package versions that they have installed. If a subscriber is reporting an issue with the managed package, the package
developer should ask them for the version number in this field as it will help troubleshooting.

Best Practices
•
•

•

An item specified with the deprecated annotation can still be referenced internally by a package developer.
The partner WSDL is loosely typed. This makes it more flexible for partners who want to integrate with multiple
organizations. Default package versions for API calls provide fallback settings if package versions are not provided by an
API call. The behavior of a package in partner API calls is defined by the latest installed package version if the default
value (Not Specified) is selected for the installed package. This means that behavior of package components, such as
an Apex trigger, could change when a package is upgraded and that change would immediately impact the integration.
Subscribers may want to select a specific version for an installed package for all partner API calls from client applications
to ensure that subsequent installations of package versions do not affect their existing integrations.
A partner that is developing a package that references another package should always supply version information for the
base package in their partner API calls. This ensures that the extension package is not affected by a component being
deprecated in the base package.

For more information about versioning and deprecation for Apex, see "Developing Apex in Managed Packages" in the
Force.com Apex Code Developer's Guide.
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About Application Distribution: Versioning and Deprecation for
Apex
Configuring Default Package Versions for API Calls
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To configure default package versions for API calls:

"Customize Application"

A package version is a set of components uploaded in a package. It is denoted by a version number,
majorNumber.minorNumber, such as 2.1. Publishers can use package versions to evolve the components in their managed
packages gracefully by releasing subsequent package versions without breaking existing customer integrations using the package.
Default package versions for API calls provide fallback settings if package versions are not provided by an API call. Many API
clients do not include package version information, so the default settings maintain existing behavior for these clients.
You can specify the default package versions for enterprise API and partner API calls. The enterprise WSDL is for customers
who want to build an integration with their Salesforce organization only. It is strongly typed, which means that calls operate
on objects and fields with specific data types, such as int and string. The partner WSDL is for customers, partners, and
ISVs who want to build an integration that can work across multiple Salesforce organizations, regardless of their custom objects
or fields. It is loosely typed, which means that calls operate on name-value pairs of field names and values instead of specific
data types.
You must associate the enterprise WSDL with specific package versions to maintain existing behavior for clients. There are
options for setting the package version bindings for an API call from client applications using either the enterprise or partner
WSDL. The package version information for API calls issued from a client application based on the enterprise WSDL is
determined by the first match in the following settings.
1. The PackageVersionHeader SOAP header.
2. The SOAP endpoint contains a URL with a format of serverName/services/Soap/c/api_version/ID where
api_version is the version of the API, such as 16.0, and ID encodes your package version selections when the enterprise
WSDL was generated.
3. The default enterprise package version settings.
The partner WSDL is more flexible as it is used for integration with multiple organizations. If you choose the Not Specified
option for a package version when configuring the default partner package versions, the behavior is defined by the latest
installed package version. This means that behavior of package components, such as an Apex trigger, could change when a
package is upgraded and that change would immediately impact the integration. Subscribers may want to select a specific
version for an installed package for all partner API calls from client applications to ensure that subsequent installations of
package versions do not affect their existing integrations.
The package version information for partner API calls is determined by the first match in the following settings.
1. The PackageVersionHeader SOAP header.
2. An API call from a Visualforce page uses the package versions set for the Visualforce page.
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3. The default partner package version settings.
To configure default package versions for API calls:
1. Click Setup ➤ Develop ➤ API.
2. Click Configure Enterprise Package Version Settings or Configure Partner Package Version Settings. These links are
only available if you have at least one managed package installed in your organization.
3. Select a Package Version for each of your installed managed packages. If you are unsure which package version to
select, you should leave the default selection.
4. Click Save.
Note: Installing a new version of a package in your organization does not affect the current default settings.

Generating an Enterprise WSDL with Managed Packages
Available in: Enterprise, Unlimited, and Developer Editions

User Permissions Needed
To download a WSDL:

"Customize Application"

If you are downloading an enterprise WSDL and you have managed packages installed in your organization, you need to take
an extra step to select the version of each installed package to include in the generated WSDL. The enterprise WSDL is
strongly typed, which means that it contains objects and fields with specific data types, such as int and string.
A package version is a set of components uploaded in a package. It is denoted by a version number,
majorNumber.minorNumber, such as 2.1. Publishers can use package versions to evolve the components in their managed
packages gracefully by releasing subsequent package versions without breaking existing customer integrations using the package.
A subscriber can select a package version for each installed managed package to allow their API client to continue to function
with specific, known behavior even when they install subsequent versions of a package. Each package version can have variations
in the composition of its objects and fields, so you must select a specific version when you generate the strongly typed WSDL.
To download an enterprise WSDL when you have managed packages installed:
1. Click Setup ➤ Develop ➤ API.
2. Click Generate Enterprise WSDL.
3. Select the Package Version for each of your installed managed packages. If you are unsure which package version to
select, you should leave the default, which is the latest package version.
4. Click Generate.
5. Use the File menu in your browser to save the WSDL to your computer.
6. On your computer, import the local copy of the WSDL document into your development environment.
Note the following in your generated enterprise WSDL:
•

Each of your managed package version selections is included in a comment at the top of the WSDL.

91

Force.com Platform

•

•

Force.com Platform Documentation Enhancements

The generated WSDL contains the objects and fields in your organization, including those available in the selected versions
of each installed package. If a field or object is added in a later package version, you must generate the enterprise WSDL
with that package version to work with the object or field in your API integration.
The SOAP endpoint at the end of the WSDL contains a URL with a format of
serverName/services/Soap/c/api_version/ID where api_version is the version of the API, such as 16.0, and
ID encodes your package version selections when you communicate with Salesforce.

You can also select the default package versions for the enterprise WSDL without downloading a WSDL in the Package
Version Settings section of Setup ➤ Develop ➤ API. Default package versions for API calls provide fallback settings if
package versions are not provided by an API call. Many API clients do not include package version information, so the default
settings maintain existing behavior for these clients.

Force.com Platform Documentation Enhancements
In addition to updates for all new features in Summer '09, the Force.com Platform documentation suite also includes several
new guides and significant updates to existing guides. For access to all Force.com platform documentation, visit the Developer
Force Documentation page.
New Guides and Tip Sheets
The following guides and tip sheets are new:
Development Lifecycle Guide: Enterprise Development on the Force.com Platform
This guide describes how an IT organization can plan, build, test, and deploy applications using a combination of
Web-based and traditional development practices. This guide is meant for IT architects, developers, and administrators
who want to understand how the development process for a Force.com app is different from the development process
of an app on another platform. It includes information on:
•
•
•
•
•

Choosing and configuring environments for development, integration, testing, and staging
Planning the delivery of multiple applications on different schedules
Using development tools such as the Salesforce Web interface, Force.com IDE, Force.com Migration Tool, and
Data Loader
Migrating setup data between environments
Deploying to a production organization

Quick Reference for Developing Packages
This reference guide includes the information a Force.com app developer needs when designing and building an application
that will eventually be packaged, including reference tables for:
•
•
•
•

All packageable components and their behaviors
Attribute behaviors for components in managed packages
Supported features in each Salesforce Edition
Feature limits for each Salesforce Edition

This guide complements the AppExchange Packaging Guide, which describes the complete packaging lifecycle, including
information on package upload, usage monitoring, and managing upgrades.
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Localizing with the Force.com IDE
This guide provides step-by-step instructions on how to use the Force.com IDE to translate large numbers of custom
labels more efficiently than with the Translation Workbench. It is meant for administrators of global organizations and
Force.com developers who want to provide translated labels with their applications.
Browser Support and Configuration
This tip sheet includes information on how to configure Microsoft Internet Explorer 6.0 and 7.0 and Mozilla Firefox
3.0 for optimal performance. It is meant for all Salesforce users.
Force.com Platform Glossary
This comprehensive glossary includes definitions for all terminology related to the Force.com platform. It is meant for
any user of the Force.com platform who wants to learn more about Force.com concepts.
Updated Guides
The following guides are significantly updated:
Security Implementation Guide
This guide provides a comprehensive overview of security for your data and applications on the Force.com platform. It
now includes information on securing and sharing data with profiles, field-level security, organization-wide defaults,
roles, and sharing rules. It also includes a chapter on security tips for Apex and Visualforce developers to help them avoid
common security attacks such as cross-site scripting, cross-site request forgery, SOQL injection, and more.
Visualforce Developer's Guide
This guide describes how to use Visualforce components and controllers to create new application interfaces for your
users. With Summer '09, it has been updated to include robust examples for every standard component in the component
reference and new chapters on defining Visualforce email templates, strategies for reusing markup in multiple Visualforce
pages, best practices, and information on Visualforce Mobile.
Force.com Apex Code Developer's Guide
This guide provides a reference for all elements of the Apex programming language. With Summer '09, the reference
section of this guide has been reorganized to list all standard classes by functionality rather than in alphabetical order.

Additional Force.com Platform Enhancements
Custom Label Limit Increased
Available in: Developer, Professional, Enterprise, and Unlimited Editions

With Summer '09, the number of supported custom labels for an organization has increased from 1000 to 5,000. To access
custom labels, click Setup ➤ Create ➤ Custom Labels.
Encoding Functions in Formulas
Available in: All Editions

Summer '09 introduces four new encoding functions that make it safe to insert data that you do not control, such as merge
field values and URL parameters retrieved with the $Request global merge field, in your custom buttons, links, Visualforce
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pages, and s-controls. The encoding functions replace or escape characters that are reserved or unsafe in HTML, JavaScript,
and URLs, which ensures the inserted data is valid and helps protect against cross-site scripting (XSS), a security vulnerability
in web applications.
HTMLENCODE
The new HTMLENCODE function encodes text strings and merge field values for use in HTML by replacing characters
that are reserved in HTML, such as the greater-than sign (>), with HTML entity equivalents, such as &gt;.
JSENCODE
The new JSENCODE function encodes text strings and merge field values for use in JavaScript by inserting escape
characters, such as a backslash (\), before unsafe JavaScript characters, such as the apostrophe (').
JSINHTMLENCODE
The new JSINHTMLENCODE function encodes text strings and merge field values for use in JavaScript within HTML
tags by inserting escape characters before unsafe JavaScript characters and replacing characters that are reserved in HTML
with HTML entity equivalents.
URLENCODE
The new URLENCODE function encodes text strings and merge field values for use in URLs by replacing characters
that are illegal in URLs, such as blank spaces, with the code that represent those characters as defined in RFC 3986,
Uniform Resource Identifier (URI): Generic Syntax. For example, exclamation points are replaced with %21.
New Languages Supported by Salesforce
Available in: All Editions

Mexican Spanish (es_MX) and Romanian (ro) are now available as end user languages for Salesforce upon request.
Users can update their personal language settings as follows:
1.
2.
3.
4.

Click Setup ➤ My Personal Information ➤ Personal Information.
Click Edit.
Select a language from the Language drop-down list.
Click Save.

Force.com Profile Enhancements
Available in: Enterprise and Unlimited Editions

With Summer '09, the following additional profile permissions are available for the Salesforce Platform, Salesforce Platform
One, Salesforce Platform Light, and Force.com - One App licenses. These administrative capabilities reduce the time required
to make changes in an organization and allow users to have more control over their particular functions within an organization.
Administrative permissions
•
•
•
•
•
•

“Edit HTML Templates”
“Manage Dashboards”
“Manage Letterheads”
“Manage Public Documents”
“Manage Public List Views”
“Manage Public Reports”
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“Manage Public Templates”
“Manage Translation” (available only if the translation workbench is enabled for your organization)
“Transfer Record”

General user permission
“View Encrypted Data” (available only if your organization uses custom encrypted fields)
Standard object permissions
•
•

“Modify All” for documents
“View All” for documents

For Salesforce Platform and Salesforce Platform One licenses only:
•
•

“Modify All” for accounts and contacts
“View All” for accounts and contacts

These permissions are disabled by default and cannot be enabled in standard profiles, but can be enabled in custom profiles.
To view a list of the active user licenses your organization has purchased, click Setup ➤ Company Profile ➤ Company
Information. To view and manage profiles, click Setup ➤ Manage Users ➤ Profiles.
Profile Enhancements
Available in: Enterprise, Unlimited, and Developer Editions

Login IP Addresses and Login Hours are Copied to Custom Profiles
In Summer '09, when you create a custom profile, any login hour and IP address range information is copied from the
existing profile to the new profile.
To create a custom profile:
1.
2.
3.
4.

Click Setup ➤ Manage Users ➤ Profiles.
Click New on the User Profiles page.
On the Clone Profile page, select an existing profile to clone, give the new profile a name, and click Save.
Click Edit to change the profile as necessary.

Profile Change Tracking Added to Setup Audit Trail
With Summer '09, profile changes are tracked at a more granular level in the setup audit trail history, including details
on changes to profile name and description, user permissions, object permissions, record type assignments, field-level
security, page layouts, custom application settings, tab settings, and desktop integration clients. For example, when a
permission is enabled in a profile, the audit trail history records the profile, the permission that changed, whether it was
enabled or disabled, who made the change, and when the change was made.
Note: Details on changes to Apex class access and Visualforce page access are not tracked in the setup audit
trail history.

To view the setup audit trail history, click Setup ➤ Security Controls ➤ View Setup Audit Trail.
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Tip: If you regularly download your organization's six-month audit trail file, you may have set up custom filters
to search for changes to specific profiles. If your search criteria for the Action column is Changed profile
[profile name], make sure that the filter uses begins with and not equals.

Role and Territory Hierarchies of 1,000 or More—List View Unavailable
Available in: Professional, Enterprise, Unlimited, and Developer Editions

With Summer '09, the Show in list view option is not available for hierarchies with 1,000 or more roles or territories. Instead,
you can select Show in tree view and Show in sorted list view, which allow you to restrict the amount of data shown on a
page. Using these options, you can quickly load a page, even if your organization has a large number of roles or hierarchies.
To view your organization's roles, click Setup ➤ Manage Users ➤ Roles, then choose one of the view options from the
drop-down list.
To view your organization's territories (if enabled), click Setup ➤ Manage Territories ➤ Hierarchy, then choose one of the
view options from the drop-down list.
S-controls and Visualforce
Visualforce pages are considered the next-generation of s-controls and should be used instead of s-controls whenever possible,
both for their increased performance and the ease with which they can be written.
Caution: S-controls have been superseded by Visualforce pages. Salesforce will, sometime after January 2010, remove
the ability to create and distribute new s-controls. Existing s-controls will be unaffected.
The following table outlines the differences between Visualforce pages and s-controls.
Visualforce Pages

S-Controls

Required technical skills

HTML, XML

HTML, JavaScript, AJAX Toolkit

Language style

Tag markup

Procedural code

Page override model

Assemble standard and custom
components using tags

Write HTML and JavaScript for entire
page

Standard Salesforce component library Yes

No

Access to built-in platform behavior

Yes, through the standard controller

No

Data binding

Yes

No

Developers can bind an input component
(such as a text box) with a particular field
(such as Account Name). If a user saves
a value in that input component, it is also
saved in the database.

Developers cannot bind an input
component to a particular field. Instead,
they must write JavaScript code that uses
the API to update the database with
user-specified field values.

Yes

No, must bring in Salesforce stylesheets
manually

Stylesheet inheritance
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Visualforce Pages

S-Controls

Yes, by default

Yes, if coded in JavaScript using a
describe API call

If a user attempts to save a record that
violates uniqueness or requiredness field
attributes, an error message is
automatically displayed and the user can
try again.

If a user attempts to save a record that
violates uniqueness or requiredness field
attributes, an error message is only
displayed if the s-control developer wrote
code that checked those attributes.

Interaction with Apex

Direct, by binding to a custom controller Indirect, by using Apex webService
methods through the API

Performance

More responsive because markup
executes on platform

Less responsive because every call to the
API requires a round trip to the
server—the burden rests with the
developer to tune performance

Page container

Native

In an iFrame

Search Enhancements
Available in: All Editions

Search Result Ordering
There is a change to the order of results returned by search in certain circumstances, as well as which records are returned.
Previously, when relevancy scores for results were the same, records with the oldest creation date were returned first.
With Summer '09, the date a record was last indexed for search is used, so that the most-recently indexed records are
returned first. This change affects searches over large volumes of records of the same object type on a query that matches
thousands of results. Users may observe that the order of some results may change. In addition, records that were more
recently added or modified are more likely to appear in search results.
Search Optimized for Japanese, Chinese, and Korean
A new organization preference has been added for searching content that is in Japanese, Chinese, and Korean. By enabling
the feature, the sidebar search will return optimized results for those language. Do not check this option if you expect
content and searches to be mostly in other languages.
This can be managed under Setup ➤ Customize ➤ Search.
Use Recently Viewed User Records for User Lookups
If this feature is enabled, the list of records returned from a user auto-complete lookup and a user blank lookup is taken
from the user's recently viewed user records.
This can be managed under Setup ➤ Customize ➤ Search.
Security Assertion Markup Language (SAML) 2.0 Supported
With Summer '09, Salesforce supports Security Assertion Markup Language (SAML) 2.0 for single sign-on.
In addition, after you have configured your organization for SAML, you can validate the SAML response sent by your identity
provider using the SAML Validation page. To validate a SAML response:
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1. Click Setup ➤ Security Controls ➤ Single Sign-On Settings, configure Salesforce for SAML, then click SAML
Assertion Validator.
2. Enter your SAML response into the text box, and click Validate. You can use either a text or a base64 encoded response.
Security Question Required When User Resets Password
The first time a user logs in, or the first time a user who was created prior to Summer '09 changes his or her password, the
user is prompted to select and answer a security question. This question is part of any user-initiated password reset. Security
questions do not appear for users logging in using either delegated authority or SAML.
More Information Emailed to User When Password Reset Rejected
If a user would not be allowed to login to Salesforce because of security settings for the organization, such as if an organization
has restricted IP addresses, and they are trying to log in from an IP address outside of that range, the user is not allowed to
reset his or her password. For Summer '09, Salesforce also sends the user an email, detailing the policy that is preventing them
from resetting their password.
Profile Sharing Overrides
Available in: Professional, Enterprise, Unlimited, and Developer Editions

When an object is selected in the Sharing Settings page, the page includes a Sharing Overrides related list, which shows any
profiles that ignore sharing settings for that object. For each profile, the list specifies the permissions that allow it to override
sharing settings. The “View All Data” and “Modify All Data” permissions override sharing settings for all objects in the
organization, while the object permissions “View All” and “Modify All” override sharing settings for the named object.
To view the Sharing Overrides related list in the Sharing Settings page:
•
•

Click Setup ➤ Security Controls ➤ Sharing Settings.
Select an object from the Manage sharing settings for list.

User Interface Enhancements
Available in: All Editions

New Option to Load Record Detail Pages More Quickly
With Summer '09, you can choose to load related lists on record detail pages asynchronously. To view the Enable Separate
Loading of Related Lists option, click Setup ➤ Customize ➤ User Interface. You must have the "Customize Application"
permission to modify user interface settings.
Select this option to enable the separate loading of record detail pages: primary record details load first, followed by
related list data. When you enable this option, users see primary record details immediately; as related list data loads,
users see a progress indicator. Separate loading can improve performance on record detail pages for organizations with
large numbers of related lists. This option is disabled by default. Note that this option does not apply to Visualforce
pages, user pages, the self-service portal, or other pages for which you cannot control the layout.
New Default Values for Certain User Interface Options
With Summer '09, the following user interface options are selected by default for all new organizations:
•
•

Enable Hover Details
Enable Inline Editing
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Enable
Enable
Enable
Enable

Enhanced Lists
Home Page Hover Links for Events
Drag-and-Drop Editing on Calendar Views
Hover Links for My Tasks list

Previously, these options were not selected by default. To view these options, click Setup ➤ Customize ➤ User Interface.
Note: User interface settings for existing organizations are not changed.

Toggle Spell Checker Functionality
You may choose to enable or disable the Spell Checker used in the application by going to Setup ➤ Customize ➤ User
Interface. The Spell Checker is available when sending emails, creating and editing activities, and in other places within
the application.
Workflow and Approval Process Enhancements
Available in: Enterprise, Unlimited, and Developer Editions

Email Alerts for Case Comment Workflow
Now, users with the "Customize Application" permission can create workflow rules that automatically send email alerts
to designated users when comments are added to cases.
To create such a workflow rule:
1. Click Setup ➤ Create ➤ Workflow & Approvals ➤ Workflow Rules to access the workflow rules list page.
2. On the workflow rules list page, click New Rule.
3. Select Case Comment in the Select object drop-down list.
4. Click Next.
5. Enter a rule name. Optionally, enter a description for the rule.
6. Select the evaluation criteria.
7. Choose criteria are met.
8. Enter the following criteria: Case Comment: Published equals True.
9. Click Save & Next.
10. Click Add Workflow Action and choose New Email Alert.
11. Enter a Description and Unique Name for the email alert.
12. Choose the email template to send when the rule is triggered.
13. Select the recipients of the email alert and click Add.
14. Optionally, enter up to five email addresses that will also receive the email alert when the rule is triggered.
15. Click Save.
For more information about creating workflow rules, see "Creating Workflow Rules" in the Salesforce online help.
Language Characteristics of Workflow Tasks and Email Notifications
With Summer '09, the language chosen for created tasks and optional email notifications now depends on several factors.If
the subject was translated, Salesforce creates the task in the assignee's language. If the subject was translated, and if you
checked Notify Assignee for the task, Salesforce sends the email in the assignee's language. However, if only the comments
field was translated, Salesforce creates the task and sends the email in the language of the user who triggered the task.
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Unique Name Added to Workflow Actions and Approval Processes
With Summer '09, a Unique Name field is now available in:
•
•
•
•
•
•

Approval processes
Approval process steps
Email alerts
Field updates
Outbound messages
Tasks

The unique name is used to refer to a component when using the Force.com API. In managed packages, the unique
name prevents naming conflicts on package installations. The requirement for uniqueness is only within the selected
object type. You can have actions of the same type (for example, two email alerts) with the same unique name, provided
they are defined for different objects, such as one for Campaigns and one for Opportunities. The Unique Name field
can contain only underscores and alphanumeric characters. It must be unique within the selected object type, begin with
a letter, not include spaces, not end with an underscore, and not contain two consecutive underscores.
With the addition of the Unique Name field, the following fields no longer have uniqueness requirements, starting
with the Summer '09 release:
•
•
•

Name field in approval processes, field updates, and outbound messages
Subject field in tasks
Description field in email alerts

New Behavior for Displaying Missing Values in Line Charts
Available in: All Editions

With Summer '09, Salesforce does not plot missing (null) values on Line and Line Grouped charts. If a missing value occurs
in the middle of a data set, Salesforce displays a gap in the line. With prior releases, Salesforce plotted a missing data point
with the value zero.
Also with Summer '09, in Line Cumulative and Line Grouped Cumulative charts, if the data set contains a missing value,
Salesforce continues the line using the previous value in the data set. With prior releases, Salesforce plotted a missing data
point with the value zero.
These charts now account properly for missing values.
Force.com - Free User License
Available in: All Editions

With Summer '09, the Force.com - Free user license is available. The Force.com - Free user license is designed for users who
need access to one custom app but not to standard CRM functionality. Force.com - Free users are entitled to the same rights
as Salesforce Platform users, plus they have access to an unlimited number of custom tabs. However, they are limited to the
use of one custom app, which is defined as up to 10 custom objects, and they do not have access to Accounts and Contacts
objects.
Note: Users with a Force.com - Free user license cannot edit or create new dashboards and can only view dashboards
if the Running User of the dashboard also has a Force.com - Free license.
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Each license provides an additional 1 MB of data storage and 1 MB of file storage, regardless of the Salesforce Edition.
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